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Course Description

Classroom for Teachers
This course provides classroom teachers with an introduction to the basic 
concepts and operation of the SASIxp Classroom module. It includes 
login/logout procedures, accessing classes and student information, 
adding, dropping and moving students on the seating chart, taking 
attendance, and assigning academic and citizenship grades and 
comments.

Expected Outcomes for Teachers

Upon completion of this course, the participant will be able to:

! Start SASIxp Classroom.
! Use the SASIxp Classroom screen functions.
! Access classes taught.
! Add new students to the seating chart.
! Remove dropped students from the seating chart.
! Move students onto, and within, the seating chart.
! Take attendance.
! View a student’s attendance record.
! View a student’s supplemental data forms.
! View a student’s grades and standardized test records.

Classroom for Administrators
This course provides administrators with an introduction to the basic 
concepts and operation of the SASIxp Classroom module. It includes 
login/logout procedures, working with the teacher selection and class 
selection screens, setting up attendance preferences, creating and 
maintaining the seating file, and running the No Attendance by Teacher 
report (CLS01).
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Expected Outcomes for Administrators

Upon completion of this course, the participant will be able to:

! Start SASIxp Classroom.
! View a list of teacher’s classes.
! View a teacher’s class information. 
! Set up attendance preferences.
! Create the seating file.
! Maintain the seating file.
! Run the No Attendance by Teacher report.
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SASIxp Classroom

Classroom is a SASIxp module created especially for teachers. Designed 
around an on-screen seating chart complete with student photos, it 
provides a class management system you can use to quickly perform 
administrative tasks right at a classroom workstation (Macintosh or 
Windows).

You work directly from seating charts to take attendance. You can instantly 
locate the student data you need in the classroom by clicking photos in 
seating charts and selecting functions from menus. In addition, Classroom 
enables you to:

! Create and arrange seating charts.
! Add and remove students from seating charts.
! Update attendance.
! Enter grades.
! View student demographic, emergency, health and immunization, and 

discipline records as well as student test scores.
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Integration with the SASIxp Educational Software
As a fully-integrated module of SASIxp™, Classroom runs in the SASIxp 
environment and shares its graphic user interface. It also features the 
same power and ease of use that are hallmarks of SASIxp.

Once you start Classroom and select a class, you can access both SASIxp 
and Classroom features in the SASIxp environment however, it is 
recommended that you work in each system separately. 

The seating chart for the class displays on the desktop, Classroom menus 
are added to the SASIxp menu bar, and other Classroom features become 
available for your use. Because SASIxp Classroom is integrated with 
SASIxp, all information comes from central data files on the school file 
server and is the latest information available. 

As soon as you select a class, you are alerted to any adds or drops. After 
taking attendance, you can be alerted to any students needing readmit 
slips. The SASIxp database is also updated instantly whenever you take 
attendance or record grades in SASIxp Classroom.

Classroom Basics
The SASIxp Classroom module is started with its own CLASSxp icon 
directly from the Macintosh or Windows desktop.

How SASIxp Classroom starts depends on whether you are a teacher or 
an administrator (the system determines which type of user you are by 
checking your user record when you login):

! If you are a teacher, SASIxp Classroom starts when you double-click 
the CLASSxp icon. Features are available right away.

! If you are an administrator, SASIxp Classroom does not start until you 
select a teacher (which logs you in as that teacher) and select one or 
more of the teacher’s classes. It is at this point that SASIxp Classroom 
features become available. You can then use SASIxp Classroom 
features alone, use other SASIxp features alone, or use features from 
both together. When you finish working with SASIxp Classroom, you 
can close the last class without exiting from SASIxp.
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Starting and Logging In to SASIxp Classroom
Both teachers and administrators start SASIxp Classroom by double-
clicking the CLASSxp icon on the Macintosh or Windows desktop (you 
must be connected to the network first). You then log in using the 
Welcome Window that displays.

The system determines whether you are a teacher or an administrator 
(Security Officer) and which SASIxp folders and atoms (if any) have been 
assigned to you. 

If you are a teacher, you have access to your own classes and to SASIxp 
Classroom features. You also have access to any SASIxp folders and 
atoms have been assigned to you. 

User IDs and passwords are initially assigned by an administrator. Unless 
the administrator assigns a special password, it is the same as your user 
ID. You can change your password using the Change Password option 
available from the Welcome Window or from the lockout screen.

Login Steps for Teachers

Teachers log in to SASIxp Classroom by: 

Logging in to SASIxp Classroom

1. Double-click the CLASSxp icon. The Welcome Window displays.

2. In the User ID field, type your SASIxp Classroom User ID. 
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3. In the Password field, type your password. (For security reasons, 
asterisks display instead of your password). 

4. Click Login (or press Enter). 

! If you have only one class, the SASIxp desktop displays with the 
seating chart for your class. In addition, the message “Loading 
students, please wait” displays in the message center.

! If your school uses schedules and you have more than one class, 
the system displays the Class Selection window.

5. Select a class from the Class Selection window (if your class is not 
displayed already) by double-clicking the name of the class (or click 
the class name once then press Enter). 

Changing Your Password

1. Double-click the CLASSxp icon. The Welcome Window displays. 

2. In the User ID field, type your SASIxp Classroom User ID. 

3. In the Password field, type your SASIxp Classroom password. (For 
security reasons, asterisks display instead of your password). 

4. Click Change Password. The system displays the User Password 
window. 

5. In the Enter your new password field, type a new password. 

6. In the Enter your new password again field, re-type your new 
password. 
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7. Click Change to record your password and return to the Welcome 
window. 

8. Click Login to log on to SASIxp Classroom using your new password. 
(You can also click Cancel to save your password and close the 
Welcome Window or click Exit to quit SASIxp Classroom). 

Using the Class Selection Window

Select the classes you want to work with from the Class Selection window. 
This window displays the current date, teacher, default term, period, and 
course title for each class assigned to the teacher during the term 
selected.

Opening One Class

From the Class Selection window, double-click the line for the class (or 
click once to highlight then click OK). Use the scroll bar to scroll through 
the list of classes. 

If you have only one class, the system bypasses the Class Selection 
window and automatically displays the seating chart for your class.
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Displaying Classes for a Different Term

1. In the Term field, display the pop-up list of terms by clicking the arrow. 

2. Highlight the term that you want. When you release the mouse button, 
the new term displays in the Term field, and the system displays 
classes for the selected term.

How to Close Classes, Log Out and Quit Classroom

When you finish with a particular task in SASIxp Classroom, you can close 
the class, log out of Classroom, or exit from the SASIxp system. 

Closing a Class

Select the Close Class function from the Class menu to exit the current 
class (or classes) and return to the Class Selection window. 

Logging Out of SASIxp Classroom

From the Class menu, select the Logout option. You will not exit 
completely from the SASIxp system. The Welcome window displays 
enabling another user to log into the system. Use this feature when two or 
more teachers are sharing a workstation.

Quitting SASIxp Classroom

From the File menu, select the Quit option (Command/Control Q) to exit 
completely from the SASIxp system and return to the Macintosh or 
Windows desktop. The system saves your desktop arrangement including 
any open folders before quitting. 

Things to keep in mind:

! If you are a teacher and you click Cancel instead of selecting another 
class, the Welcome Window displays. From this window, you can 
either log back in or click Cancel and exit SASIxp Classroom.

! If you are a teacher with only one class, selecting Close Class displays 
the Welcome window. From here, you can either log in again or click 
Cancel to exit from SASIxp Classroom.
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A Look at Classroom Features
When you open a class, the SASIxp Classroom seating chart for that class 
displays on the desktop, Classroom menus become available on the menu 
bar, and other Classroom features become available for use in the SASIxp 
environment. 

The main features of SASIxp Classroom are:

! Seating Chart — Displays the names and photos of the students in the 
selected class or classes. When you select one or more photos in a 
seating chart, the data forms that you select from SASIxp Classroom 
menus are for those selected students.

! Class Information Window — Displays basic information for the 
selected class including date, period, term, teacher, course title, 
student name, total students in class, and total number of students 
who are present, absent, or tardy.

! Student and Class Data Forms — Contain data for individual students 
or for an entire class. To display data forms, you select them from the 
three SASIxp Classroom menus.

! Class, Personal, and Performance Menus — List of SASIxp 
Classroom functions. These display in the menu bar next to the File, 
Edit, Windows, and Data menus available for SASIxp.

Class Information Window

The Class Information window displays basic information on one selected 
class. To open the Class Information window, select the Class Info option 
from the Class menu. You can also tell the system to display Class 
Information automatically each time you locate a class by setting this 
option using Teacher Preferences in the Class menu. 
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The Class Information window remains open until you click the Close box 
(Macintosh), double-click the Control-menu box (Windows) in the top left 
corner, or click the close box (Windows 95) in the upper right corner. 

Class Information Window Fields

Field Description

Date Current day of week and calendar date. 

Select Class Displays the period, name and term of the 
selected class. 

Tch#/Teacher Name/
Room

Displays the teacher number, teacher name 
and room number of the selected class.

Course Title/Number 
Enrolled

Name of each course taught during the 
selected period and the number of students 
enrolled in each. Up to eight courses per 
period can be listed.
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Working with Data Forms

Data forms display records for individual students or for an entire class. 
The data comes from the school’s central SASIxp files, and almost all 
displayed data has been entered by school staff members in various 
SASIxp atoms. 

The exceptions are attendance data and grading data. Teachers can enter 
attendance data using the Take Attendance function on the Class menu in 
SASIxp Classroom. Depending on the update rights assigned to all 
Classroom users, you can update attendance in Class Attendance, Period 
Attendance, or Daily Attendance records. Teachers can enter grading data 
in Class Grades, Grades, and Progress records.

The data forms used for SASIxp Classroom are the same as the 
corresponding forms used for SASIxp. However, to open data forms in 
SASIxp Classroom, you select them from SASIxp Classroom menus 
instead of launching them from atoms. 

Available Data Forms

! Demographic
! Class Schedule
! Student Attendance
! Period Attendance

Student Name Name of the student currently selected. As 
you move the mouse pointer over the seating 
chart, the name of each student displays in 
this field. If two or more classes are displayed 
in the seating chart, then the course title of 
his or her section is highlighted in the Course 
Title field. 

Totals Total number of students enrolled in the 
class, as well as the total number present, 
absent, and tardy on the current date. Totals 
change as you take attendance. 

Field Description

Data form availability depends on how your school and security have 
been set up. Not all forms are available all the time.
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! Parent/Guardian
! Emergency
! Health
! Immunization
! Discipline
! Notes
! Student Grades
! Student Progress
! Student Course History
! Student Test Scores
! Full Student Data
! Student Test Scores
! Class Attendance
! Class Grades

SASIxp Classroom Menus

Most selections on the SASIxp Classroom menus enable you to display 
forms or to perform functions such as taking attendance. Available menu 
items display in black, and unavailable menu items are dimmed out. 
Functions for individual students become available only when you select 
one or more students in the seating chart. 

Class Menu Functions

The Class menu in SASIxp Classroom consists of these functions:

Function Description

Class Info Opens the Class Information window.

Take Attendance Enables you to take attendance for the 
current day or period.

Note: You can take attendance using the 
seating chart by clicking once on a 
student to mark them as absent or 
twice on the student to mark them as 
tardy.
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All Students Are Present It is mandatory to click on this menu item 
when there is 100% attendance in the class.

Note: 
This option is enabled if 

1. The “Paperless Environment” option is 
set in the General tab of the School atom.

2. It has not been selected earlier at the 
time of attendance. 

This option is disabled if 

1. You open a class again after the 
“Paperless Environment” option is set 
and you log 100% attendance in a class 
once.

2. Even a single student in the class has an 
absent record.

Show Class Attendance Displays the section ID, course number, 
period, semester, course title, teacher 
number, teacher name and seats for the 
selected class.

Show Student List Displays a list of all students in the selected 
class including students not displayed in the 
seating chart.

Show Readmits Displays a list of students who need readmit 
slips.

Show Students Entering Displays a list of students being added to the 
selected class.

Show Students Leaving Displays a list of students being dropped 
from the selected class.

Use Seating Charts Displays a submenu listing the default 
seating charts (Alphabetical) and any charts 
you have created using the Seating Charts 
function. You can display the selected class 
in one of these charts by selecting it from the 
list.

Function Description
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Seating Charts Enables you to create up to seven seating 
charts. This function is also used to remove 
created seating charts.

Print Report Displays a submenu listing three reports:

! Class Roster – not available.
! Seating Chart – not available.
! Class Attendance – Report Interface for 

ATP17 (period attendance schools) or 
ATD17 (daily attendance schools).

Preferences Displays a submenu listing Teacher 
Preferences and Class Preferences. By 
selecting one of these options, you can set 
preferences for a variety of system features.

Close Class Closes the currently selected class and 
returns you to the Class Selection window, if 
you are a teacher with more than one class. If 
you are a teacher with only one class, 
selecting Close Class displays the Welcome 
window.

Note: You cannot close the class if all 
students in the class are present and 
the menu ’All Students Are Present’ is 
not selected.

Logout Logs you out of SASIxp Classroom and 
displays the Welcome window enabling 
another teacher sharing the same 
workstation to log in to the system.

Note: To completely exit from SASIxp, select 
Quit from the File menu.

Function Description
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Personal Menu Functions

The Personal menu in SASIxp Classroom consists of these functions:

Function Description

Demographic Displays the student form for a selected 
student.

Class Schedule Displays the class schedule for a selected 
student.

Student Attendance Displays the daily attendance record for a 
selected student. 

Note: This function is available only if your 
school uses daily attendance.

Period Attendance Displays the period attendance record for a 
selected student.

Note: This function is available only if your 
schools uses period attendance.

Parent/Guardian Displays the parent/guardian record for a 
selected student.

Emergency Displays the emergency record for a selected 
student.

Health Displays the health record for a selected 
student.

Discipline Displays the discipline record for a selected 
student.

Notes Displays a form for viewing and entering 
notes about a selected student.

Full Student Data Displays all the data forms for a selected 
student. (It may take some time to display all 
the forms). 
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Performance Menu Functions

The Performance menu in SASIxp Classroom consists of these functions:

Function Description

Class Grades Displays the grade and progress reporting 
record for an entire class. If a class includes 
more than one course, double-click on the 
Section ID for the course whose records you 
wish to view.

Student Grades Displays the grade reporting record for a 
selected student.

Student Progress Displays the progress reporting record for a 
selected student.

Student Course History Displays the course history record for a 
selected student.

Student Test Scores Displays the test scores to date for a selected 
student.
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Attendance

The Classroom functions required for taking and tracking attendance are:

Functions Descriptions

Take Attendance Enables you to take attendance for each day 
or each period.

Student Attendance Displays the daily attendance record for a 
selected student. Available only if your school 
is set up for taking daily attendance. 

Note: This function is accessed from the 
Personal menu.

Period Attendance Displays the period attendance record for a 
selected student. Available only if your school 
is set up for taking period attendance.

Note: This function is accessed from the 
Personal menu.

Show Class Attendance Displays the attendance record for all the 
students in the selected class. 
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Take Attendance Function
SASIxp Classroom lets you record student attendance for the current day, 
class or period. If your school is set up to take attendance by class, block 
classes (classes lasting more than one period) are displayed on a single 
line in the Class Selection window and attendance is only taken once 
during the class. However, if your school takes period attendance, each 
period of a block class (a class lasting more than one period) is listed 
separately and attendance must be taken for each period the class meets.

To begin taking attendance select the The Take Attendance function from 
the Class menu. Each time you click a particular student photo in the 
seating chart, a different attendance code displays. You can select from a 
maximum of 12 attendance reasons defined by your school. 

The available codes and the order in which they display as you click 
student photos get defined in the Attendance Preferences atom. The 
default system attendance reasons are Unverified, Tardy and Present.

Show Readmits Displays a list of students who require 
readmit slips due to an unverified absence for 
the previous day. To display readmits 
automatically after you take attendance, 
select this as a preference using Teacher 
Preferences under Preferences on the Class 
menu.

Functions Descriptions
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As you take attendance, totals change in the Class Information window. 
When you complete taking attendance, the system immediately updates 
records in SASIxp Daily or Period Attendance files. 

You can use the Take Attendance function as many times as necessary 
throughout the day to modify attendance status or correct errors. For 
example, you might change a student’s status from Absent to Tardy or 
from Absent to Present with a legitimate office pass. 

To modify attendance information for a previous day or period, you must 
work from either the Student or Period Attendance atom or the Class 
Attendance atom. The number of days you can go back to modify 
attendance information and whether you can modify the attendance codes 
used on prior days is determined by an administrator when the Attendance 
Preferences atom is set up.

You can change the attendance reason type of a student through Period 
Attendance, Daily Attendance, Mass Change, and the Classxp module. 
You require Update or All security rights at the Field and File levels in the 
Security atom for AATD (Daily Attendance) or AATP (Period Attendance) 
in order to change the attendance.
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Update rights are the same for all SASIxp Classroom users. If an 
administrator wants to update data beyond the time limit set for SASIxp 
Classroom, then the administrator needs to do this from the SASIxp 
educational software.

Before Taking Attendance

! Acknowledge any students entering or leaving. Adds and drops display 
automatically when you open a class.

! Make sure all students in the class are displayed so that you can take 
attendance accurately. You can check this by displaying the Student 
List from the Class menu. If any students are listed in the Out of Chart 
part of the list, drag their names into the seating chart. 

! Ensure that the seating chart is the active window. If another window is 
active, the Take Attendance function is not active.

Taking Attendance

1. From the Class menu, select the Take Attendance function. The 
system displays the current date (from the network file server) and this 
message replaces the menu bar at the top of the desktop:

Taking Attendance - click here when finished
(current date)

2. Click a student’s photo to begin cycling through the list of absence 
reason codes defined by your school. Continue clicking the photo until 
the appropriate attendance reason code displays.

3. Click another student photo to assign an attendance reason to the 
student in the same way. 

If a student is inactivated for a future date using the Enrollment atom, 
you must answer "No" to the system question "Do you want this
student’s dropped classes in grading?" in order for 
Classroom to recognize when the date occurs and display the Student 
Leaving window correctly.

If the school office has already entered a verified absence for the 
student, then that absence code displays and you are not able to 
change it. 

If a student left the class, you are not able to assign attendance 
status to that student. 



Copyright © 2000–2004 Pearson Digital Learning Daily Attendance Function  21

Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous

4. Repeat steps 2 and 3 until you complete taking attendance. 

5. Click the Taking Attendance message at the top of the window. The 
menu bar returns with the Class Information window and the system 
immediately updates the SASIxp attendance file. 

Daily Attendance Function
The Daily Attendance function is available only if your school is set up as a 
Daily Attendance school. To view daily attendance records for individual 
students, select one or more students in the seating chart. From the 
Personal menu, select the Student Attendance option.

Daily attendance records contain year-to-date attendance data for the 
selected students. This data includes a list of days that a student was 
marked absent or tardy, and a student’s year-to-date attendance totals by 
absence reason and reason type.

Daily attendance data for each student also gets reflected in Class 
Attendance records displayed by the Show Class Attendance function. 

You can work from daily attendance records to update attendance data. 
Whether you can update an attendance record, and how far back you can 
go to perform updates, depends on the number of days defined in the 
Attendance Preferences atom.

The Daily Attendance function displays three tabs:

! Show Full Year 
! Days of Activity 
! Attendance Totals 

 Show Full Year Tab

The Daily Attendance Show Full Year tab contains the school’s Attendance 
Calendar with a date for each school day (or half-day). Blank cells indicate 
that a student was present. Absence reason codes indicate that a student 
was absent or tardy and why. Cells marked N/E indicate that the student 
was not enrolled in school on that day. The screen displays codes for 
holidays, vacation, staff development, and other non-attendance days as 
well.
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Show Full Year Fields

Days of Activity Tab

The Daily Attendance Days of Activity tab displays all dates with 
attendance activity other than present. The dates displayed on this screen 
are those for which the student was marked absent or tardy in the Full 
Year tab or in the Class Attendance atom. You can update absence 
reasons from this screen.

The Days of Activity screen contains the same absence data as the Full 
Year tab. The difference is that the Days of Activity screen displays data 
only for those dates on which a student was marked absent or tardy.

Field Description

Date Displays the starting date for each week in 
the school Attendance Calendar (starting 
dates fall on Mondays). 

Day fields Displays attendance data for day of the week 
(M - F). Monday is the starting day. Saturday 
displays only if the Meet on Saturday option 
is selected in the School atom. 
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Days of Activity Fields

Field Description

Ln The line number for each record.

Date The date on which a student was marked 
absent or tardy (displays the current school 
year to the present date).

Day of Week The day of the week for the date.

Reas The absence reason code for the absence or 
tardy attendance mark. (This column displays 
as AM and PM columns if your school is set 
up for half-day attendance). 
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Attendance Totals Tab

The Daily Attendance Totals tab displays two matrices containing a 
student’s absence totals for each absence reason and each reason type. 
A particular absence type may include several absence reasons. 

For example, absences for Illness and Activity may both get classified as 
an Excused absence type. Totals are calculated from data entered in the 
Daily Attendance Show Full Year screen. The last two rows of the Reason 
Type matrix contain the absence total to date and days enrolled to date.

Attendance Totals Matrices

Field Description

Absence Reason matrix Each row contains data for one reason. The 
Reason column displays the absence reason 
name and code. The Totals column displays 
a student’s year-to-date total for the reason. 
(Sub-columns for AM and PM display under 
the Totals heading if your school is set up for 
half-day attendance).
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Period Attendance Function
The Period Attendance function is available only if your school is a 
secondary school or an elementary school that uses schedules and is set 
up for Period Attendance. To view period attendance records for individual 
students, select a student from the seating chart, then select Period 
Attendance from the Personal menu. 

Period attendance records enable you to view a list of periods that a 
student was marked absent or tardy and to view a student’s year-to-date 
attendance totals for each period by absence reason and type.

You can work from period attendance records to update attendance data. 
Whether you can update a period attendance record, and how far back 
you can go to perform updates, depends on the number of days defined in 
the Attendance Preferences atom.

The Period Attendance function displays four tabs:

! Full Year 
! Days of Activity 
! Reason Totals 
! Type Totals 

Full Year Tab

The Period Attendance Full Year tab contains a row for each date in the 
Attendance Calendar and columns for each period defined in the School 
atom. It also includes an All Day column to enter a student’s attendance 
for the entire day. Blank cells indicate that a student was present. Absence 
reason codes indicate that a student was absent or tardy and why. 

Reason Type matrix Each row contains data for one absence 
reason type. The Reason Type column 
displays the name of each system-supplied 
absence reason type. The Totals column 
displays a student’s year-to-date total for 
each reason type. The last two rows contain 
the student’s absence total to date and the 
days enrolled to date. (Sub-columns for AM 
and PM display for half-day attendance). 

Field Description
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Cells marked N/E indicate that the student was not enrolled in school on 
that day. The tab displays codes for holidays, vacation, staff development, 
and other non-attendance days.

Full Year Tab Fields

Field Description

All Day Displays the all-day code for a student’s 
attendance on a particular date. Entries in 
this column affect apportionment reports and 
get reflected in the monthly attendance 
summaries that SASIxp prints. 

Attendance Period 
Columns

Display a student’s attendance data for each 
period on a particular date. There is a column 
for each period defined in the School atom. 
Period columns are grayed if a student is not 
enrolled in classes during those periods. 
(These columns are labeled Bell Periods if 
your school is set up using period rotation or 
scheduling cycles).
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Days of Activity Tab

The Period Attendance Days of Activity tab displays all dates with 
attendance activity (other than present) in one or more periods. These are 
the dates on which a student was marked absent or tardy in the Period 
Attendance Full Year tab or in the Class Attendance atom.

The Period Attendance Days of Activity tab contains the same rows and 
columns as the Full Year tab. The difference is that the Days of Activity tab 
displays only data for dates on which a student was marked absent or 
tardy for one or more periods.

Days of Activity Tab Fields

Field Description

All Day Displays the all-day code for a student’s 
attendance on a particular date. Entries in 
this column affect apportionment reports and 
get reflected in the monthly attendance 
summaries that SASIxp prints. 
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Reason Totals Tab

The Period Attendance Reason Totals tab displays totals for a particular 
student’s absence reasons by period and by day. The totals are calculated 
from data entered in the Period Attendance Full Year tab or the Class 
Attendance atom. 

Reason Totals Tab Fields

Each row contains data for one absence reason. There can be up to 50 
absence reasons, all of which are defined by your school during user 
setup. Each absence reason gets assigned an absence reason type. 
Absence types are system-defined and cannot be modified.

Attendance Period 
Columns

Display a student’s attendance data for each 
period on a particular date. There is a column 
for each period defined in the School atom. 
Period columns are grayed if a student is not 
enrolled in classes during those periods. 
(These columns are labeled Bell Periods if 
your school is set up using period rotation or 
scheduling cycles).

Field Description
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Type Totals Tab

The Period Attendance Type Totals tab displays a student’s total for each 
absence reason type by period and by day. A particular absence type may 
include several absence reasons. For example, absences for Illness and 
Activity may both get classified as an Excused absence type. 

Absence type totals are calculated from data entered in the Full Year tab. 
Absence types, rather than Absence Reasons, are generally used for 
apportionment reporting.

Type Totals tab Fields

Each row contains data for one absence reason type. The Totals row 
displays total absences to date for each reason type. The Percent of 
Absence row displays what percentage of the total absences occurred in 
each period. The Days Enrolled to Date row displays the total number of 
days to date that the student has been enrolled in school. 

Show Class Attendance Function
To view the attendance record for an entire class, go to the Class menu 
and select the Show Class Attendance option. The Class Attendance 
screen displays daily attendance or period attendance data for the last 40 
days in the school Attendance Calendar (only 20 days display if your 
school is set up for half-days). 
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Students display in alphabetical order by last name in the left column of 
the screen. All columns to the right display days in the Attendance 
Calendar. 

Data entered when you take attendance in SASIxp Classroom gets 
reflected in student class attendance records as well as in individual 
student attendance records for daily or period attendance.

You can work from class attendance records to update attendance data. 
How many attendance days you can go to perform updates depends on 
the number of days defined in the Attendance Preferences atom.

If you have more than one class displayed in the seating chart and you 
select the Show Class Attendance option, the system displays a screen 
listing all classes. Double-click a class to display attendance data for that 
class. A shaded class indicates the class does not meet.

Updating Data from Class Attendance

Whether you can update daily or period attendance data in the Class 
Attendance screen is determined by the Attendance Preferences set up. 
Any changes that you make are reflected in individual student records as 
well as in the class attendance records. 

To update either daily attendance or period attendance data from a class 
attendance record, you can click cells in the Class Attendance screen and 
select absence reasons from the school-defined list that displays (this 
includes choices for present and tardy). When you select an absence 
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reason for a cell that already contains data, the existing data is replaced. 
Changes or new entries are reflected in students’ daily attendance or 
period attendance records.

Updating Data in the Class Attendance Screen

1. From the Class menu, select the Show Class Attendance option. 

2. Locate the student (row) and the date (column) for which you want to 
update attendance data. (You might need to use the scroll bars). 

3. Click the cell for the student and date that you want to display a pop-up 
list of attendance reasons, and select a reason from the list. (The cell 
remains blank if you select the Present option). 

4. Click Save to save the updated data (or click Undo to restore original 
data). 

To mark a student present at a positive attendance school, select 
the Absence Type from the pop-up list defined with a type of Positive 
(Present, Positive, and so on.).
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Class Menu

A number of SASIxp Classroom functions are designed for use on a class-
wide basis as opposed to use with individual students only. Nearly all 
class-related functions are listed on the Class menu. The exception is 
Class Grades, which is listed on the Performance menu.

Class-related features and functions include the Class Information 
window, attendance functions, seating chart functions, and class grades. 
The class-related functions discussed in this section are:

! Show Student List – Displays a list of all students in the class, 
including those not displayed in the seating chart.

! Show Students Entering – Displays a list of students entering the 
selected class.

! Show Students Leaving – Displays a list of students being dropped 
from the selected class.

! Close Class – Closes the selected class and returns you to the Class 
Selection window where you can select another class or exit from 
SASIxp Classroom.
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All Students Are Present Function
This menu enables you to confirm 100% attendance in the class. Before 
exiting the seating chart, it is mandatory to click this option if all the 
students in the class are present 

The All Students Are Present option is enabled if and only if Paperless 
Environment is set and all the students of the selected class are present. 
If any student has been marked absent, this option gets disabled.
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Procedure for Setting up Paperless Environment

1. Open the SASIxp.ini file.

2. In the SASIxp.ini file, enter UseAttendMonitoring = True in the 
Monitoring section.

3. Save the SASIxp.ini file.

4. Close the file.

5. Run the SASIxp application.

6. Open CLASSxp.

7. Select a teacher from the Teacher Select window.

8. Select the class from the Class Selection window.

9. Take attendance using the Seating Charts and the Take Attendance 
procedure.

10. If all the students in the class are present, select All Students Are 
Present from the menu. 

This option gets disabled if there is an absence record.

11. Close Class. 

If you attempt to close the class without selecting the All Students Are 
Present menu in case of 100% attendance, you get an error message 
stating "All students are present. Select the option ’All Students Are 
Present’ from the Class Menu before exiting”.

When this option is selected, an 'AllPresent' entry is made in the 
Attendance Inspector atom along with the Section ID/Advisor No., Date, 
Time and the User ID of the person making the entry.

Show the Student List Function
From the Class menu, select the Show Student List function (or use 
Command/Control L) to view a list of all students in the current class or 
classes. You can use the list as a reference or as an aid in setting up 
seating charts. The Student List consists of two sections:

! Students in Chart (those who display in the seating chart). A scroll bar 
displays when the section contains more than six students. 
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! Students Out of Chart (those who are enrolled in the class but do not 
display in the seating chart). A scroll bar displays when the section 
contains more than five students.

Setting Preferences
SASIxp Classroom enables you to choose default settings for a variety of 
system features. From the Class menu, you can access Preferences that 
display the Teacher Preferences window and the Class Preferences 
window. 
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Teacher Preferences Window

Teacher Preferences Window Fields

Field Description

Open form on
double-click

Determines which student information form 
opens automatically when you double-click a 
student in the seating chart. You can select 
another form from the pop-up list.

Show Class Information
Window

Determines whether Class Information 
displays automatically.

Show Readmits After
Taking Attendance

Determines whether readmits display 
automatically after you take attendance. 
Scheduled for version 4.0. 

Hide Student Last 
Names

This option determines if you want to hide 
students’ last names so that only their first 
names display in seating charts.
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Class Preferences Window

Class Preferences Window Fields

Displaying a Preference Window

From the Class menu, select the Preferences option. The system displays 
a submenu. From the submenu, select Teacher Preferences or Class 
Preferences to display the Teacher Preferences window or the Class 
Preferences window. 

Selecting Preferences

Specify among the available preferences in either the Teacher 
Preferences window or the Class Preferences window. 

Saving Preferences

Click Save or press Enter to save preferences. To restore previous 
settings before you exit from the window, click Close. 

Field Description

Maximum Seating
Chart Size

Enables you to set your own defaults for the 
maximum seating chart size for the selected 
class. System defaults are six rows and 
seven columns (which accommodates 42 
students). You can customize the seating 
chart size. 
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Setting Rows and Columns in Class Preferences

1. In the Rows field, type a new number for rows in the seating chart. 

2. In the Columns field, type a new number for columns in the seating 
chart. 

3. Click Save to save the new seating chart size.

Working with Seating Charts
The first time you select a class, the seating chart displays in alphabetical 
order by student with the chart name Alphabetic. This chart always 
remains in alpha-order. The user may create an unlimited number of 
custom seating charts. Custom seating charts may be rearranged in any 
order and may also exclude specified students from the chart.such custom 
charts might be used when more than one class meets in the same 
classroom during the same period. A custom seating chart may also be 
created by selecting the Seating Charts option from the Class menu. Enter 
a name for the new chart in the Chart Name field and click Duplicate. This 
creates a copy of the alphabetic chart. You can then rearrange the 
students displayed in the chart to create a new custom chart. Up to six 
new seating-charts using the Seating Charts function on the Class menu. 
To display a class in any of the available arrangements, go to the Class 
menu and select the Use Seating Chart function. 

Things to keep in mind:

! If you want to move a student to a seat that is beyond the edge of the 
chart, you can resize the chart or use the scroll bars to display more of 
the seating chart. You can also drag the student’s photo to edge of 
chart and continue to hold it as the window scrolls to the seat you want. 
When the seat you want displays, release the mouse to drop the 
student photo onto the seat. 

! You can scroll through student photos on a seating chart by clicking 
the vertical and horizontal scroll bars. 

! The system saves any changes you make to a seating chart under the 
title of the current seating chart. 

! You can work from the Student List on the Class menu to move 
students in and out of seating charts.



Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous

40  Working with Seating Charts Copyright © 2000–2004 Pearson Digital Learning

Seating Charts Window

Seating Charts Window Fields

Field Description

Chart Name Displays the name of the chart selected in the 
list of available charts. You can use this field 
to enter new seating chart titles or change 
existing titles.

Available Seating
Charts List

Lists all available seating charts. The system 
accommodates an unlimited number of chart 
titles. To change the default seating chart, 
click another chart name in the list. To display 
a class in one of the charts, click the chart 
name.

Add Button Enables you to add a blank seating chart. 
Adding a seating chart in the Seating Charts 
window also adds that chart to the list 
displayed by the Use Seating Chart option. 
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Working With Seating Charts

The Use Seating Chart function on the Class menu enables you to display 
a class in any seating chart that exists for the selected class. Seating 
charts may vary among classes.

The Use Seating Chart function displays the list of existing seating charts 
as well as the Alphabetical chart defined by the system for each class. The 
seating charts are displayed in the order they were created.

Displaying a Chart

1. From the Class menu, select the Use Seating Chart function. The 
system displays a submenu of all existing seating charts for the class. 

2. Select the chart that you want. The class displays in the seating chart 
arrangement that you use. The system also places a check mark next 
to the selected seating chart arrangement. 

3. You may also select the seating chart you want to use as the default, 
by clicking its name on the Seating Charts po-up list from the Class 
menu.

Remove Button Enables you to remove a seating chart. 
Removing a seating chart in the Seating 
Charts window also removes that chart from 
the list displayed by the Use Seating Chart 
option.

Change Button Enables you to change the name of an 
existing seating chart.

Duplicate Button Enables you to create a new seating chart by 
duplicating an existing chart. You can 
perform modifications to the new chart. 

Student List Button Enables you to display the student list from 
the Seating Charts window. You can then 
add students to, or remove students from, 
seating charts. 

Field Description



Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous

42  Working with Seating Charts Copyright © 2000–2004 Pearson Digital Learning

Creating Seating Charts

Use the Seating Charts function on the Class menu to create seating chart 
arrangements. The system displays the Seating Charts window. 

To create a seating chart, you use the Seating Charts function on the 
Class menu. This brings up the Seating Charts window. You can create an 
unlimited number of different seating arrangements for each class. You 
supply the name for each seating arrangement that you define, and you 
can change the names of any existing seating chart titles. You can also 
change or delete existing seating chart arrangements. 

Things to Keep in Mind

! When you add a new seating chart, the chart remains blank until you 
add students to it.

! The most efficient way to create a seating chart is to duplicate an 
existing chart. That way you can work from a chart with an existing 
student population, and add or delete students as required without 
having to add all new students. 

! If you rearrange an existing seating chart, the new arrangement is 
saved automatically under the old chart’s name.

! You cannot remove the alphabetical seating chart that comes with 
SASIxp Classroom.

! You cannot remove the last seating chart in the Seating Charts window 
if only one chart is listed.

Creating a New Seating Chart

1. From the Class menu, select the Seating Charts option. 

2. In the Chart Name field, type a name for the new chart. 

3. Click Add. The system displays a blank seating chart. (The new 
seating chart is now available from the Seating Charts and the Use 
Seating Charts functions). 

4. Click Student List to display the list of students currently enrolled in the 
class.

5. In the Student Out of Chart section of the student list, click student 
names then drag and drop them into the Students in Chart section. 
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6. The system displays student photos in the seats on the charts and 
adds the students’ names to the Student In Chart section of the 
student list. You can drag the student photo into the position of your 
choice.

7. Close the student list. (Click once on the Close box for Macintosh or 
double-click the Control menu box in the upper left corner for 
Windows). 

8. Close the Seating Charts window. (Click once on the Close box for 
Macintosh or double-click the Control menu box in the upper left corner 
for Windows). The system saves the new seating chart. 

Removing a Seating Chart

1. From the Class menu, select the Seating Charts function. 

2. Select the chart title for the chart that you want to remove. (You cannot 
remove a chart if it is the only one in the list). 

3. Click Remove. The system displays a message asking you to confirm 
deletion of the chart. 

4. Click OK to delete the chart permanently from the list of available 
seating charts for that class. 

Changing a Seating Chart Name

1. From the Class menu, select the Seating Charts option.

2. Select a chart from the list available. The title displays in the Chart 
Name field.

3. In the Chart Name field, type a new chart name. 

4. Click Change. The new name replaces the old name on the list of 
available charts accessed from both the Seating Charts and Use 
Seating Charts functions. 

Duplicating a Seating Chart

1. From the Class menu, select the Seating Charts option. 

2. Select the chart you want to copy from the available list. The class 
displays in the selected chart. 

3. Click Duplicate. The system copies the selected chart and duplicates 
its name followed by a unique number in the Chart Name field. 
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4. Rename the new chart by typing a different name in the Chart Name 
field. Click Change.

5. Rearrange the new chart by moving students or by working from the 
Student List (click Student List to display this list). 

! Move students on the chart by clicking student names in the 
Students Out of Chart section then dragging and dropping them 
onto available seats. 

! Move students out of the chart by clicking their names in the 
Students In Chart section then dragging and dropping them into 
the Students Out of Chart section.

Moving Students into a Seating Chart

You have two options:

The preferred method is to click student names in the Students Out of 
Chart section then drag and drop them into the Students In Chart section 
where names display in alphabetical order and photos display in the next 
available seats. 

OR

Click student names in the Students Out of Chart section then drag and 
drop them onto available seats where their photos display. 

Moving Students Out of a Seating Chart

Click student names in the Students In Chart section of the Student List 
then drag and drop the names into the Students Out of Chart section of the 
Student List. The system removes student photos from the seating chart. 

Show Students Entering Function
SASIxp Classroom automatically displays the names of new students 
entering a class when you first open the class. You can either 
acknowledge new students at that point or you can acknowledge them 
later using the Show Students Entering function on the Class menu. 

This function displays the same window that displays when you open a 
class with new students. New students are listed in this window until you 
click their names to acknowledge them.
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Whether you acknowledge added students right away or later, you must 
do so before you take attendance for the period or the day.

Acknowledging an Add Right Away

1. Open a class. The system displays a window with all adds (new 
students) for that class if any exist.

2. Click the name of an added student. The system marks the student 
with a dot and adds the student to the Students Out of Chart section of 
the Student List. You can add this student to the seating chart now or 
later. 

OR

3. Click the name of an added student then drag and drop that student 
onto an available seat in the seating chart. The system marks the 
student name with a dot and adds the student to the Students In Chart 
section of the Student List. 

4. Close the window. If the Student List displays, close this in the same 
way.

Pearson Education Technologies recommends acknowledging adds 
immediately.
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Acknowledging an Add Later

1. Open a class. The system displays a window with all adds (new 
students) for that class if any exist.

2. Close the window that displays the new students. 

3. Later go to the Class menu and select the Show Students Entering 
option to display the window of new students again. 

4. Click the name of an added student. The system marks the student 
with a dot and adds the student to the Students Out of Chart section of 
the Student List. You can add this student to the seating chart now or 
later. 

OR

5. Click the name of an added student then drag and drop that student 
onto an available seat in the seating chart. The system marks the 
student name with a dot and adds the student to the Students In Chart 
section of the Student List.

6. Close the window. If the Student List displays, close this in the same 
way.

Show Students Leaving Function
SASIxp Classroom automatically displays the names of students leaving a 
class when you first open the class. (In addition, the system tags the 
student photos as DROPPED). 

You can either acknowledge dropped students immediately or you can 
acknowledge them later using the Show Students Leaving function on the 
Class menu. 

This function displays the same window that displays when you open a 
class with drops. Dropped students are listed in this window until you click 
their names to acknowledge that they are leaving the class. 

Acknowledging drops later enables you to continue working with that 
student until you finish gathering notes and data about that student’s time 
in your class. However, you cannot take attendance for dropped students.

Pearson Education Technologies recommends acknowledging adds 
immediately.
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Acknowledging a Drop Right Away

1. Open a class. The system displays a window with all dropped students 
for that class if any exist.

2. Click the names of all dropped students. The system marks the 
students with a dot. 

3. Close the window. The system removes the selected students from the 
Student List and from the seating chart. 

Acknowledging a Drop Later

1. Open a class. The system displays a window with all dropped students 
for that class if any exist.

2. Close the window that displays the dropped students. 

3. Later go to the Class menu and select the Show Students Leaving 
option to redisplay the window of dropped students.

4. Click the names of all dropped students. The system marks the 
students with a dot.

5. Close the window. The system removes the selected students from the 
Student List and from the seating chart.
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Personal Menus

This section covers the SASIxp Classroom forms and functions used for 
displaying personal student data such as demographic information, 
discipline information, and health information. You can access forms that 
display the data for individual students from the Personal menu. 

The information that displays in personal data forms comes from your 
school’s central data files in SASIxp atoms. The top line of each form 
displays the same view-only data for each student:

! Name
! Grade Level
! Gender
! ID
! Track (if your school uses tracks)

For most student personal data forms, you can view data but you cannot 
modify data unless you have been assigned security rights to the files that 
contain the student data. Even if you have security rights, you may find 
that certain fields on a student personal data form are locked. 

Although you typically cannot modify data in student forms, SASIxp 
Classroom enables to you create and maintain extensive notes for 
individual students.
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The personal forms and functions discussed here are:

Demographic Function
To view the demographic profile for a student, click the student in the 
seating chart. From the Personal menu, select the Demographic option (or 
use Command/Control D). This displays the Student forms with student 
demographic data that comes from the SASIxp Student atom. 

Field Description

Demographic Displays the demographic data for a selected 
student.

Class Schedule Displays the class schedule for a selected 
student.

Student Attendance Displays the daily attendance record for a 
selected student (for schools using Daily 
Attendance).

Period Attendance Displays the period attendance record for a 
selected student (for schools using Period 
Attendance).

Parent/Guardian Displays the parent/guardian record for a 
selected student.

Emergency Displays the emergency record for a selected 
student.

Health Displays the health record for a selected 
student.

Discipline Displays the discipline record for a selected 
student.

Notes Enables you to enter extensive notes on a 
selected student. You can maintain one 
notes record for each of your students. 

Full Student Data Displays multiple information forms for a 
selected student. You can either use the 
default display (all information forms on the 
Personal and Performance menus) or set a 
display of your choice. 
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The student Demographic function displays three pages:

! Student Page 1 displays the basic student information needed most 
often such as address, primary parent/guardian name, home phone, 
and birth date.

! Student Page 2 displays additional student information such as alias or 
nickname, locker number, school of residence, next school or grade, 
last school, post-secondary plans, citizenship, and language.

! Student Page 3 displays user codes and data that applies to a 
student’s home circumstances, promotion/retention status, driver 
training eligibility, and so on.

Student Page 1

Student Page 1 Fields

Field Description

Address Student’s residential and mailing addresses 
(if both were entered when the student was 
enrolled). 

City City part of a student’s mailing address.

St State part of a student’s mailing address.
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Zip Code Zip code portion of a student’s mailing 
address (US or Canadian).

Parent/Guardian Name Name of the student’s primary parent or 
guardian. 

Family ID ID number that enables you to link siblings at 
the same school. 

Telephone Student’s home phone number.

UnL Indicates whether a student’s home phone 
number is listed or unlisted. (X indicates 
unlisted, Blank indicates listed). 

Birthdate Student’s date of birth.

Soc Sec No. Student’s Social Security Number.

Eth Student’s ethnic code. 

ConcSch/Home The three digit number of any school the 
student is attending concurrently with the 
home school such as a continuation school 
or school for the handicapped. (X in the 
Home field indicates that the concurrent 
school and home school are the same, Blank 
indicates that they are not the same). 

Bus 1
Bus 2

Information on buses used by the student 
(such as the number of the bus a student 
takes or the number of his or her bus route).

Enter Date Date the student entered your school. If the 
student re-enrolled, the most recent enter 
date displays. 

Code Enter code selected for the enter date 
displayed. This code indicates the 
circumstances under which the student 
enrolled at your school. If the student re-
enrolled, the most recent enter code displays. 

Leave Date Date the student left your school. 

Field Description
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Code Leave code selected for the leave date 
displayed. This code indicates the 
circumstances under which the student left 
your school. 

OrgEntDate Original enter date for the first time a student 
enrolled at your school. This differs from the 
date in the Enter Date field if the student has 
enrolled at your school more than once.

Code Original enter code for the first time a student 
enrolled at your school. This may differ from 
the code in the Enter Code field if the student 
has enrolled at your school more than once. 

EntGrd Student’s grade at the first time of enrollment 
at your school. 

Yr/Grad Student’s year of graduation. 

Tchr # (Advsr) Teacher number or advisor number for the 
teacher currently assigned to the student. 

Name Name of the teacher or advisor currently 
assigned to the student.

Room # Number of the student’s current home room. 

Couns # Number of the guidance counselor assigned 
to a student or of the teacher assigned as the 
guidance counselor.

Name Name of the guidance counselor assigned to 
the student.

ESL Indicates the student’s proficiency level in 
English. 

IS Instructional setting code indicating any 
special program in which the student is 
enrolled. 

Field Description
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Student Page 2

Student Page 2 Fields

Field Description

Birthplace Student’s place of birth.

Verif Indicates whether the student has provided a 
document verifying place of birth.

Alias Name Any alternate last name the student uses 
instead of his or her given name.

Nick Name Any nickname by which the student is known. 

Locker Number of the student’s main locker.

Alt Locker Number of an additional locker assigned to 
the student. 

Dst/Res Number of the school district in which the 
student resides.
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Sch/Res School number for the school near which the 
student resides. In most cases, this is the 
same as the number for your school. 
However, it is different in cases where a 
student from outside your district (or from a 
different area within your district) has been 
allowed to attend your school.

Grid # Displays the geographic grid number 
indicating the location of the student’s 
residence.

Summer Schl School number for the school at which the 
student attends summer classes.

Apport% Percent of full-day apportionment allowed 
based on student attendance. Scheduled for 
version 4.0.

NxtSch Number of the next school the student is 
scheduled to attend after leaving your school. 

NxtGrd Indicates next year’s grade level for students 
who are promoted more than one grade or 
held back.

NxtTrk Number for the next attendance track 
assignment for the student. 

LstSch Number of the school the student attended 
last.

PostSec Code indicating the student’s post-secondary 
plans.

Ctz Code indicating the student’s citizenship 
status.

PrimLang Language in which the student is most fluent. 

HomeLang Language spoken in the student’s home. 

CoorLang Language in which letters to a parent or 
guardian should be written.

Field Description
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Student Page 3

Program Indicates whether the student is enrolled in a 
special program like LEP (X indicates Yes, 
Blank indicate No). 

Permit Code Attendance permit code for permit allowing a 
student from another school (in or out of your 
district) to attend your school.

Date Date an attendance permit was issued.

Grad Date Date that the student graduates. 

End of Year
Status

A state-specific field that indicates the 
student’s status at the end of the year. 
Choices might include C for completed, G for 
graduated, R for retained, and P for 
promoted.

Field Description
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Student Page 3 Fields

Field Description

User Codes Fields for all user codes defined by the 
school and state for tracking student 
information.

User Num Fields for all user code numbers defined by 
the school and state for tracking student 
information.

Alternate ID 1 & 2 First and second alternate ID’s assigned to 
the student.

Meals A selected check box indicates that the 
student participates in the Free and Reduced 
Meals Program.

Foster Home A selected check box indicates that the 
student resides in a foster home.

Homeless A selected check box indicates that the 
student is homeless.

Gifted & Talented A selected check box indicates that the 
student is in the Gifted and Talented 
program. 

Migrant A selected check box indicates that the 
student lives with a migrant family.

PE Waiver A selected check box indicates that the 
student is excused from taking physical 
education.

Restrict Pers. Info A selected check box indicates that the 
student’s personal data can only be released 
to the primary parent or guardian.

Refugee/Immig A selected check box indicates that the 
student is a refugee or immigrant.

Retain A selected check box indicates that the 
student has been retained.
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Class Schedule Function
To view the class schedule for a student, click the student in the seating 
chart. From the Personal menu, select the Class Schedule option. This 
displays a Classes screen with the student’s schedule for the current term 
(information comes from the SASIxp Classes atom). 

Classes that the student dropped during the current school year display in 
the History screen from the Classes atom. 

There are three pages in the Classes atom:

! Classes Screen
! Other Info Form
! History Screen

Displaying Detail Pages

To display a detail form for a particular class, double-click the line number 
for that class in either the Classes screen or the History screen. Once you 
display the detail form for a class, you can remain in that form and display 
detail forms for other classes using the Multi-Record Selection Bar on the 
right side of the page. 

DrvTrnElig A selected check box indicates that the 
student is eligible for driver’s training. The 
field next to this indicates the date on which 
the student is eligible for this training. 

Receives Financial Aid A selected check box indicates that the 
student is eligible to receive financial aid.

No Auto Dial A selected check box indicates that phone 
calls to the student’s home should not be 
placed by an auto dialer.

Comp Ed A selected check box indicates that the 
student participates in a Compensatory 
Education program.

Field Description
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The Multi-Record Selection Bar contains a number for each class in either 
the Classes screen or the History screen. Click any number to display a 
detail form for a different class for the same student. Use the scroll bar to 
scroll through the numeric selections in consecutive order. 

Classes Screen

The Classes screen displays data for each section to which a student is 
assigned. From the Classes screen, you can double-click any line number 
to display a detail page for any class in which a student is enrolled. 

Classes Fields

Field Description

Section ID Section number assigned to the class for a 
particular period and teacher.

Beg Starting period for the section.

End Ending period for the section.

Term Term duration for the section.
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Other Info Form 

The Other Info form displays scheduling information that affects a 
student’s placement in classes. This information can include teams to 
which the student is assigned, the lowest and highest period to which a 
student can be assigned, and a balance code.

Days Days of the scheduling cycle that the section 
meets (displays only if your school is set up 
to use scheduling cycles). 

Crs ID Course number assigned to the course. (If 
the course has multiple sections, all sections 
have the same course number). 

Course Title Name of the course.

Tch Teacher number of the teacher assigned to 
the section.

Teacher Name Name of the teacher assigned to the section.

Room Room number where the section meets.

Field Description
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Other Info Form Fields

History Screen

The History screen displays any course sections that students have 
dropped from their schedules during the current year. You can double-
click a record to display a detail page for the dropped class. 

Field Description

Team Any team or teaching group to which the 
student is assigned.

Low Prd Earliest period the student can take a class.

High Prd Latest period the student can take a class.

Balance Code used to balance a class. Scheduled for 
version 4.0.
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History Fields

History Detail Form

Field Description

Section ID Section number for the selected section of a 
course. Section numbers are unique for a 
specific period and teacher.

Beg Beginning period for the section.

End Ending period for the section.

Term Term duration for the section.

Crs ID Number of the course. One course number 
can have multiple sections.

Course Title Name of the course.

Tch Teacher number of the teacher assigned to 
the section.

Teacher Name of the teacher assigned to the section.

Drop Date Date a student dropped the section.
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History Detail Form Fields

Field Description

Section ID Section number for the selected section of a 
course. Section numbers are unique for a 
specific period and teacher.

Beg Beginning period for the section.

End Ending period for the section.

Term Term duration for the section.

Crs ID Number of the course. One course number 
can have multiple sections.

Course Title Name of the course.

Tch Teacher number of the teacher assigned to 
the section.

Teacher Name of the teacher assigned to the section.

Start Date Date a student started the section.

Teacher Aide Indicates whether the student is a teacher 
aide for the section.

Override Term Term code displaying which term of a year-
long class the student is enrolled in. Data 
displays here only if a student is taking a 
partial term.

Merge Grades from
Dropped Course

Displays the number for the dropped class if 
the grade for that class should be merged 
with the grade for the current class.

Tag Indicates whether a section was added or 
dropped (A indicates Added, D indicates 
Dropped).
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Parent/Guardian Function
You can view the parent/guardian records with address and employment 
information for a selected student. Click the student in the seating chart. 
From the Personal menu, select the Parent/Guardian option to display the 
parent/guardian records. The system retrieves data from the information 
entered in the Parent Guardian atom. The first record that displays 
consists of information for the primary parent or guardian of the student. 
The Parent Guardian atom consists of two pages:

! Personnel/Employment Form
! Comments Form

Displaying Additional Parent/Guardian Records

The Multi-Record Selection Bar displays the number of parents or 
guardians assigned to each student. The bar displays on the right side of 
both the Personal/Employment form and the Comments form in the Parent 
Guardian atom, and it provides you with quick access to all the parent/
guardian records for a student. Numbers for each parent/guardian are 
assigned in the order that the parents and guardians are added for the 
student. Use the arrows to scroll through the parent/guardian records in 
consecutive order. 

Personal/Employment Form
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Personal/Employment Form Fields

Field Description

Relationship Identifies the relationship of the parent/
guardian to the student. (REL table)

Last Name The last name of the parent/guardian.

First Name The first name of the parent/guardian.

Middle Name The middle name of the parent/guardian.

Title The title that the parent/guardian prefers on 
correspondence. (TTL table)

Address Mailing address (street or PO box) for the 
parent/guardian. 

City The city part of the parent/guardian’s mailing 
address. 

State The state part the parent/guardian’s mailing 
address. 

Zip Code The zip code part of the parent/guardian’s 
mailing address. 

Telephone Home phone of the parent/guardian. 

Alt Telephone Any alternate number such as a beeper or 
car phone for the parent/guardian. 

Extn The extension for the alternate phone 
number. 

Soc Sec No. The social security number of the parent/
guardian.

Birthplace The birthplace of the parent/guardian.

Employer The name of the company at which the 
parent/guardian is employed.

Occupation The occupation of the parent/guardian.

Work Address The address (street or PO box) of the parent/
guardian’s employer.
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City The city part of an employer’s address.

State The state part of an employer’s address.

Zip Code The zip code part of an employer’s address. 

Work Telephone The work phone number for the parent/
guardian. 

Extn Any extension to be used with the work 
phone number. 

Work Hrs: Frm/To The Frm (from) field indicates the hour that 
the parent/guardian typically arrives at work. 
The To field indicates the hour that the 
parent/guardian typically leaves work. 

Ctz The citizenship status of the parent/guardian 
(Y is US citizen, N is Not a US citizen, Blank 
is Unknown). 

E/M Indicates whether Extra Mailings should be 
sent to this parent or guardian in addition to 
the primary parent or guardian. X indicates 
Yes for Extra Mailings and tells SASIxp to 
print extra labels for that adult. Blank 
indicates that the individual does not receive 
mailings. An X in the Rsp field tells the 
system to print labels for the primary parent 
or guardian.

Mil Indicates whether the parent/guardian 
military status entitles the school to special 
funding. (X indicates for Not Eligible, Blank 
indicates Eligible). 

Cont Indicates whether the parent/guardian is 
allowed contact with a student. (X indicates 
Contact is Not Allowed, Blank indicates 
Contact is Allowed). 

Field Description
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Comments Form

The Comments form displays additional information or comments about 
the parent or guardian of a student. 

Res Indicates whether a student resides with the 
parent/guardian. (X indicates student resides 
with parent/guardian, Blank indicates student 
does not reside with parent/guardian). 

Rsp Indicates whether the parent/guardian has 
primary responsibility for the student. (X 
indicates Responsible for Student, Blank 
indicates Not Responsible for Student). An X 
tells the system to print mailing labels for the 
primary parent/guardian. Leave blank for 
additional parents/guardians.

Field Description
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Comments Form Fields

Emergency Function
You can view emergency information including important medical alerts 
and contact information for a selected student. Click the student in the 
seating chart. From the Personal menu, select the Emergency option to 
display emergency records. The system retrieves data from the 
information entered in the Emergency atom. The Emergency atom 
consists of two pages:

! Emergency Contacts Form
! Other Contacts Form
! Emergency Information Form

Field Description

Education Level Highest education level achieved by the 
parent/guardian. 

User Codes 1-5 Displays special school-defined parent/
guardian data. 

Comments Additional parent/guardian information such 
as custody arrangements, special family 
situations, or instructions regarding to whom 
a student can or cannot be released. 
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Emergency Contacts Form

Emergency Contacts Form Fields

The Other Contacts form displays the same information for third and 
fourth emergency contacts. 

Field Description

First Contact Name of the first person to contact in an 
emergency. This may or may not be the 
student’s primary parent or guardian (it could 
be a relative, neighbor, or baby sitter). 

Telephone Phone number of the primary emergency 
contact.

Extn Any extension to the phone number of the 
primary contact.

Relationship First contact’s relationship to the student 
(such as Brother, Aunt, Friend).

Address Street address or PO box portion of primary 
contact’s address.

City City part of primary contact’s address.
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St State part of primary contact’s address.

Zip Code Zip code portion of primary contact’s address 
(U.S. or Canadian). 

Secondary Contact Name of next person to contact in case the 
primary contact cannot be reached.

Telephone Phone number of the secondary emergency 
contact.

Extn Any extension to the phone number of the 
secondary contact.

Relationship Secondary contact’s relationship to the 
student (such as Neighbor or Baby Sitter).

Address Street address or PO box part of secondary 
contact’s address.

City City part of a secondary contact’s address.

State State part of a secondary contact’s address.

Zip Code Zip code part of a secondary contact’s 
address (U.S. or Canadian). 

Field Description
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Emergency Info Form

Emergency Info Form Fields

Field Description

Medical Alert 1 Primary medical condition that might affect a 
student (such as diabetes or asthma). 

Medical Alert 2 Secondary medical condition that might 
affect a student (such as allergies). 

Physician Name of the doctor to contact in an 
emergency.

Telephone Phone number of the doctor to contact in an 
emergency.

Extn Any extension to the doctor’s phone number.

Comments Additional medical information such as 
medications taken by a student or medical 
equipment required for a medical condition.



Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous

72  Health Function Copyright © 2000–2004 Pearson Digital Learning

Health Function
You can view student health information that might affect a student’s 
performance or attendance and records of health incidents that occurred 
at school or during the school year. You can also view student 
immunization information.

Click the student in the seating chart. From the Personal menu, select the 
Health option to display health records. The system retrieves data from 
information entered in the Health atom. The Health atom consists of four 
pages:

! Health History Screen
! Immunizations Screen
! Medical Form
! Health Screenings Screen

How to Display Health Records

Each screen in the Health atom consists of multiple records for a student. 
To view more detail about a particular health record in a screen, double-
click the line number for the record that you want to display a detail form. 
(You can also highlight the record row then click Open). Fields in detail 
forms correspond to columns in matrices. To remove highlighting from 
rows, click the Ln column heading. 

If you display a detail form for a particular health record, the multi-record 
selection bar displays on the right when there is more than one record in 
the health screen. Click a number on the multi-record selection bar to view 
a detail form for another record. 
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Health History Screen

The Health History screen displays a row for each health-related incident 
that occurs at school or that affects a student’s attendance or school 
performance. 

Health History Fields

Field Description

Ln Displays the line number for each incident. 
Double-click a line number to display the 
detail form for an incident.

Code Displays the school-defined code for an 
incident. 

Comment Description of the three-letter code (such as 
“broken bone” for a BRK code). 

Eff. Date Date the health incident began. 

End Date Date the health incident ended. For some 
health incidents (such as allergies) there may 
not be an end date.
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Immunizations Screen

The Immunizations screen displays data related to separate immunization 
records. It includes a row for each immunization required for a particular 
student. The screen allows a maximum of six required vaccinations for any 
immunization type. If a vaccination date cell is shaded, then a vaccination 
is not required. The number of unshaded date cells in a vaccination row 
indicate the number of required vaccinations. Immunization requirements 
are defined in the Vaccine Definition atom. 

V Code The code that describes the type of visit that 
was made.

Visitation Comment Description of the visitation code. 

Fol Date (Follow up 
date)

Date when the student should be checked 
again.

Time In The time the incident occurred. 

Time Out The time the incident ended. 

Field Description
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Immunizations Fields

Field Description

Ln Line number for each vaccination row. 
Double-click a line number to display the 
detail form for an immunization.

Vaccination Name of the required vaccination. 

Compliant Indicates whether the student is in 
compliance with the indicated immunization. 

Exempt Displays an exempt code letter if the student 
is exempt from vaccination. (Exempt 
students may display as non-compliant with 
the immunization). 

1st Date Displays the date the first required 
vaccination for each immunization was 
administered. 

2nd Date
through 6th Date

These columns contain the dates that 
additional vaccinations for each immunization 
were administered. In columns where a 
vaccination is required, the cells are 
unshaded. In columns beyond the last 
vaccination required, the cells are shaded.
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Medical Form

The Medical form displays information about tuberculosis skin tests and 
chest X-Rays. 

Medical Form Fields

Field Description

Date Given Date of skin test. 

mm indur Size of swelling in millimeters.

Impression
(Positive/Negative)

Indicates whether skin test was positive or 
negative. If marked positive, the Chest X-Ray 
window displays.

Film Date Date of chest X-Ray.

Impression
(Normal/Abnormal)

Indicates whether chest x-ray was normal or 
abnormal.
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Health Screening Screen

The Health Screening screen displays student information about 
screenings and referrals for vision and hearing. It also displays student 
height and weight information. 

Health Screenings Fields

Field Description

Ln Displays the line number for each screening 
record. Double-click a line number to display 
the detail form for a screening.

Date The date the screening was performed. 

Grade Student’s grade when the screening was 
performed.

Vision

Color Displays eye color (EYE table). 

R Eye Displays code letter for right eye screening 
results. 
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L Eye Displays code letter for left eye screening 
results.

Referral Identifies action taken based on screening 
results. 

Date Date the referral was acted upon.

Aid Displays vision corrective aid (blank indicates 
none). 

Hearing

R Ear Displays code letter for right ear screening 
results.

L Ear Displays code letter for left ear screening 
results.

Referral Identifies action taken based on screening 
results. 

Date Date the referral was acted upon. 

Aid Displays hearing corrective aid (blank 
indicates none).

Height

Height Student’s height in inches and hundredths 
(for example, 66.25).

Pct Percentile ranking of this student’s height 
measurement based on averages for age 
and gender.

Weight

Weight Student’s weight in pounds.

Field Description
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Discipline Function
To view discipline records for a student, click the student in the seating 
chart. From the Personal menu, select the Discipline option to display the 
Discipline screen of the student’s entire disciplinary history (information 
comes from the SASIxp Discipline atom). From the Discipline screen, you 
can double-click a line number to display a detail page for a discipline 
incident record.

You can view only those disciplinary incidents that are marked with a 
security level that is the same, or lower than, your security level 
assignment in your User record. 

Once you display the detail form for a disciplinary incident, you can remain 
in that form and display detail forms for other incidents using the Multi-
Record Selection Bar on the right side of the page.

Pct Percentile ranking of the student’s weight 
measurement based on averages for age 
and gender.

Test Late Field Yes indicates the test was performed late. 
Blank indicate that test was not performed 
late. 

Field Description
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Discipline Screen

The Discipline screen displays data related to disciplinary infractions that a 
particular student commits at school. It includes a row for each disciplinary 
infraction. You may need to use the scroll bar or resize the screen to view 
additional screen fields. 

Discipline Fields

Field Description

Ln Displays the line number for each discipline 
incident record. Double-click a line number to 
display the detail form for an incident.

Incid Date Displays the date each discipline incident 
occurred.

Cd Displays a code for each disciplinary 
infraction a student commits.

Description Displays descriptions that indicate what each 
discipline code represents. 

Referred By Displays the name of the person who alerted 
the school office to an incident. This person 
might be a counselor, teacher, or parent.
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Refer Date Displays the date that the incident was 
referred to the office.

S/L Displays the security level required for 
access to information about the incident. The 
higher the security level, the more serious the 
incident and the more limited the access. 
Security levels are defined along with codes 
in the Discipline Codes atom. Discipline 
clearance levels are defined in the Dis Sec 
Lvl field (Discipline Security Level) in the 
User atom.

Days Displays the number of days for the 
disciplinary action for each incident.

Hrs Displays the number of hours for the 
disciplinary action for each incident.

Dmts Displays the demerits for each incident. 
Demerits are defined in Discipline Codes 
atom.

Prev Action 1 and 2 Any previous actions taken regarding this 
incident. There are two columns for previous 
actions.

Incid Loc 1 and 2 The location(s) in which the incident took 
place.

Incid Con The context of the incident:

During school hours.

Outside school hours at 
school-sponsored 
activity.

Outside school hours at non-school-
sponsored activity.

Tch Conf Indicates whether a teacher conference was 
held regarding the incident.

Time In Displays the time the incident or detention 
started. Enter four digits, and the system 
completes the colon and the AM or PM.

Field Description
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Discipline Detail Form

The Discipline Detail form displays information for a single disciplinary 
incident. The fields in this form are the same as the fields in the Discipline 
screen; however, the detail form also includes a Comments field. 

Time Out Displays the time the incident or detention 
ended. Enter four digits, and the system 
completes the colon and the AM or PM.

Action Setting The campus where disciplinary action 
occurred. 

Action Length The actual length of the disciplinary action. 

Diff. Reason The code for the reason that the actual 
disciplinary time served (Action Length) is 
different from the original disciplinary time 
required (Days or Hrs). 

Disposition button Select an incident then click this button to 
enter incident disposition information on the 
Disposition page.

Field Description
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Disposition Screen

Disposition Fields

Field Description

Disposition Displays the code indicating the disciplinary 
action taken (such as WRN for warning or 
SUS for suspension). Disposition codes are 
defined in the Tables atom. (DSP table)

Strt Date Displays the starting date for the disciplinary 
action for each incident.

End Date Displays the ending date for the disciplinary 
action for each incident. 

Action Taken By Displays the name of the individual who 
carried out the disciplinary action for each 
incident.

Notes Comments on the disposition. 
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Notes Function
SASIxp Classroom enables you to record extensive notes on each student 
in all of your classes. You can maintain a notecard of information about 
each of your students. 

You can choose how to use the Notes function. For example, you can 
records assignment objectives, track student performance, or jot down 
observations about a student. The large text field of your individual 
notecards can accept over 32,000 characters. You can add to notes as 
well as the Cut, Copy, and Paste features on the Edit menu. 

Notes Form

Using Notecards

These instructions indicate how to use notecards. 

Before you create a student notecard, be sure the ANOT file has been 
created.
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Entering Notes in a Notecard

1. Click a student in the seating chart.

2. From the Personal menu, select Notes (or use Command/Control N). 
The notecard for the selected student displays. 

3. Click inside the notecard and begin typing. (A scroll bar displays on the 
right if you begin to fill the area). 

4. Click Save to save your student notes. 

Printing a Notecard

1. Click a student in the seating chart.

2. From the Personal menu, select Notes (or use Command/Control N). 
The notecard for the selected student displays.

3. From the File menu, select Print (or use Command/Control P). A dialog 
box displays with the name of the selected student in the Printout Title 
field. The system automatically selects the Format as a Window 
option. 

4. Click OK to print the notecard.

Full Student Data Function
You can use the Full Student Data function to display multiple data forms 
at once instead of one form at a time. From the Personal menu, select the 
Full Student Data function (or use Command/Control F).

The system defaults to opening all forms available on the Personal and 
Performance menus when you select the Full Student Data function. The 
forms are arranged in a cascaded pattern with each title bar visible. 

You can redefine the forms that open by default using the Set Full Data 
function. Hold down the Option key (Macintosh) or the Alt key (Windows) 
and go to the Personal menu where the Set Full Data function becomes 
available. 

As you work in a notecard, it’s a good idea to periodically select 
Save from the File Menu to save the text entered. The form remains 
open and you can then enter more text.
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Selecting Forms for Full Student Data

1. Click any student in the seating chart.

2. Open the student data forms that you want to include in the Full 
Student Data function. (Forms for individual students are listed on the 
Personal and Performance menus). 

3. Rearrange the forms if you want. 

Arranging Student Information Forms
! To move an open form in front of all other forms open, click anywhere 

on the form that you want in front. 
! To move an open form in front of all other open forms and into a 

different position, click and hold the form title bar and drag the form to 
where you want it. 

! To arrange forms in a cascade pattern, go to the Windows menu and 
select Arrange Windows.
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Using Performance Functions

This section discusses the SASIxp Classroom forms and functions that 
you can use to display performance data for individual students and entire 
classes. You can access performance data forms and functions from the 
Performance menu. 

Functions for individual students include:

! Viewing and entering grades.
! Viewing and entering progress report grades.
! Viewing course histories and test score histories.

Functions for entire classes include viewing and entering grades.

When you enter student grades in SASIxp Classroom, the system saves 
them in SASIxp files used by the Grades and Class Grades atoms as well 
as other grade reporting atoms. Administrators can use the grade 
reporting atoms to post grades by teacher, calculate student GPAs, print 
report cards, and print grade or progress reports. 

The functions covered in this section are:

Function Description

Class Grades Displays the grade reporting record for an 
entire class.
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Class Grades Function
The Class Grades function enables you to view the class-specific grade 
record for each student enrolled in a selected class (whereas the Student 
Grades function enables you to view all class grade records for an 
individual student). To display the Class Grades matrices for the class 
displayed in the seating chart, go to the Performance menu and select the 
Class Grades option. 

From either Class Grades matrices that displays, you can view all student 
grades that have been entered to date, record student grades, and view 
credits attempted for all students in the class. Any grades that you record 
or update in the Grades matrices or in the Class Grades matrices display 
and update in both the Grades and Class Grades atoms and files. 

The Class Grades function displays two pages:

! Show All Data Matrix
! Show Marks Only Matrix

The difference between these two pages is that the Show All Data matrix 
can display student grades, conduct codes, work habits, comment codes, 
absence/tardy data, and credits attempted for the reporting period 
depending on how your school is set up. (This setup information is defined 
in the Grading Setup folder). The Show Marks Only matrix displays only 
student grades for each reporting period. Both matrices include the same 
Student Information fields. 

You can double-click any student record in either Class Grades matrix to 
display all grade records for the selected student. 

Student Grades Displays the grade reporting record for an 
individual student.

Student Progress Displays the progress reporting record for an 
individual student.

Student Course History Displays the course history records for an 
individual student.

Student Test Scores Displays the test scores to date for an 
individual student.

Function Description
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Class Grades Show All Data Matrix

Class Grades Show Marks Only Matrix
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Class Grades Matrices Fields

Field Description

Student Information

Ln Line number of each student grade record for 
the class. 

Student ID The unique identification number of the 
student. 

Student Name The student’s name. 

Reporting Period

Mark Description 
columns

Contain academic grades earned by each 
student in the class. There can be multiple 
mark columns for each reporting period 
depending on your school’s grading setup. 

Cond If displayed, represents the conduct code 
earned for the class. 

W/H If displayed, represents the code for the 
student’s work habits. 

Cmt columns If one or more columns displays, represents 
comment code for the student. 

Absence/Tardy Column
(All Abs, All Tdy)

If displayed, represents total student 
absences or tardies. The column headings 
depend on your school’s setup for reporting 
attendance data here. Totals may be defined 
as cumulative or limited to each marking 
period.

Credits Attempt. If displayed, represents number of credits the 
student attempted to earn upon completion of 
the class. Your school can automatically 
enter credits by running Update Grades. 
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Recording Class Grades

You can enter data in any Reporting Period fields on either Class Grades 
matrix. However, it is possible that credit and attendance information 
already exists in the student record. If this is the case, then you should not 
replace data in those fields on the matrices (data you enter in those fields 
can be overridden with data from the Grades atom entered by an 
administrator). The pop-up lists with school-defined items that are 
available in many of the Reporting Period fields enable you to enter data 
that is consistent with your school’s grading system. 

Entering Grades and Codes

1. Locate the row for the student record that you want. 

2. Display the Class Grades matrix from which you want to work. 

3. Go to the appropriate mark field for the current reporting period. Select 
a grade from the pop-up list. 

4. In all other fields displayed for that student record, determine whether 
you want to enter data. Use the pop-up lists in each field to enter data. 

5. Click Save to save your data (or click Undo to erase data or to restore 
original data if you updated existing information). 

6. Click Close to close the Class Grades matrix. 

Student Grades Function
The Student Grades function enables you to view all class grade records 
for an individual student (whereas the Class Grades function enables you 
to view the class-specific grade record for each student enrolled in a 
selected class). To display the Grades matrices for a particular student, 
click the student in the seating chart then go to the Performance menu and 
select the Student Grades option. 

From either Grades matrix that displays, you can view all of a student’s 
grades that have been entered to date by all of the student’s teachers. As 
a teacher, you can also enter grades for students in your classes. Any 
grades that you record or update in the Grades matrices or in the Class 
Grades matrices display and update in both the Grades and Class Grades 
atoms and files. 
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The Student Grades function displays two pages:

! Show All Data Matrix
! Show Marks Only Matrix

The difference between these two pages is that the Show All Data matrix 
can display student grades, conduct codes, work habits, comment codes, 
absence/tardy data, and credits attempted for the reporting period 
depending on how your school is set up. (This setup information is defined 
in the Grading Setup folder). The Show Marks Only matrix displays only 
student grades for each reporting period. Both matrices include the same 
Class Information fields.

Besides using the Student Grades function, you can also view individual 
student grade records by double-clicking a student record in either Class 
Grades matrix. 

Grades Show All Data Matrix
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Grades Show Marks Only Matrix

Grades Matrices Fields

Field Description

Class Information

Ln Line number for each class in a student’s 
grade record.

Beg Per Starting period for the class.

End Per Ending period for the class.

Crs-ID Identification number of the course. 

Crs Title Name of the course.

Teacher Name Name of the teacher for the class. 

Reporting Period
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Recording Student Grades

You can enter data in any Reporting Period fields on either Grades matrix. 
However, it is possible that credit and attendance information already 
exists in the student record. If this the case, then you should not replace 
data in those fields the matrices (data you enter in those fields can be 
overridden with data from the Grades atom entered by an administrator). 
The pop-up lists with school-defined items that are available in many of the 
Reporting Period fields enable you to enter data that is consistent with 
your school’s grading system. 

Mark Description 
columns

Contain academic grades earned by the 
student in each the class. There can be 
multiple mark columns for each reporting 
period depending on your school’s grading 
setup. 

Cond If displayed, represents the conduct code 
earned for the class. 

W/H If displayed, represents the code for the 
student’s work habits. 

Cmt columns If one or more columns displays, represents 
comment code for the student. 

Absence/Tardy columns
(All Abs, All Tdy)

If displayed, represents total student 
absences or tardies. The column headings 
depend on your school’s setup for reporting 
attendance data here. Totals may be defined 
as cumulative or limited to each marking 
period.

Credits Attempt. If displayed, represents number of credits the 
student attempted to earn upon completion of 
the class. Your school can automatically 
enter credits by running Update Grades. 

Field Description
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Entering Grades and Codes

1. Locate the row for the student record that you want. 

2. Display the Grades matrix from which you want to work. 

3. Go to the appropriate mark field for the current reporting period. Select 
a grade from the pop-up list. 

4. In all other fields displayed for that student record, determine whether 
you want to enter data. Use the pop-up lists in each field to enter data. 

5. Click Save to save your data (or click Undo to erase data or to restore 
original data if you updated existing information). 

6. Click Close to close the Grades matrix. 

Student Progress Function
The Progress function enables you to view all class progress records for 
an individual student. To display the Progress matrices for a particular 
student, click the student in the seating chart then go to the Performance 
menu and select the Student Progress option. 

From either Progress matrix that displays, you can view all of a student’s 
progress marks that have been entered to date by all of the student’s 
teachers. As a teacher, you can also enter progress marks for students in 
your classes. 

The Progress function displays two pages:

! Show All Data Matrix
! Show Marks Only Matrix

The difference between these two pages is that the Show All Data matrix 
can display student grades, conduct codes, work habits, comment codes, 
absence/tardy data, and credits attempted for the reporting period 
depending on how your school is set up. (This setup information is defined 
in the Grading Setup folder). The Show Marks Only matrix displays only 
student grades for each reporting period. Both matrices include the same 
Class Information fields.
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Progress Show All Data Matrix

Progress Show Marks Only Matrix
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Progress Matrix Fields

Field Description

Class Information

Ln Line number of course progress record. 

Beg Per Starting period for the class.

End Per Ending period for the class.

Crs-ID Identification number for the course. 

Crs Title Name of the course.

Teacher Name Name of the teacher for the class. 

Reporting Period

Mark columns Contains the progress mark earned by the 
student in each class. There can be multiple 
mark columns for each reporting period 
depending on your school’s grading setup. 

Cond If displayed, represents the conduct code 
earned for the class. 

W/H If displayed, represents the code for the 
student’s work habits. 

Cmt columns If one or more columns display, represents 
the comment code for the student. 

Absence/Tardy columns
(All Abs, All Tdy)

If displayed, represents total student 
absences or tardies. The column headings 
depend on your school’s setup for reporting 
attendance data here. Totals may be defined 
as cumulative or limited to each marking 
period.

Credits Attempt. If displayed, represents number of credits the 
student attempted to earn upon completion of 
the class. Your school can automatically 
enter credits by running Update Grades. 
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Recording Progress Grades

You can enter data in any Reporting Period fields on either Progress 
matrix. However, it is possible that credit and attendance information 
already exists in the student record. If this the case, then you should not 
replace data in those fields the matrices (data you enter in those fields can 
be overridden by an administrator). The pop-up lists with school-defined 
items that are available in many of the Reporting Period fields enable you 
to enter data that is consistent with your school’s grading system.

Entering Progress Marks and Codes

1. Locate the row for the student record that you want. 

2. Display the Progress matrix from which you want to work. 

3. Go to the appropriate mark field for the current reporting period. Select 
a progress mark from the pop-up list. 

4. In all other fields displayed for that student record, determine whether 
you want to enter data. Use the pop-up lists in each field to enter data. 

5. Click Save to save your data (or click Undo to erase data or to restore 
original data if you updated existing information). 

6. Click Close to close the Progress matrix.

Course History Function
The Course History function enables you to view all courses that a student 
has taken to date (from freshman year) with significant course and student 
information such as grade received, school year, student grade level, and 
course attendance data. Information can include data from other schools. 
You can also view student GPA calculations and class rank information, 
credit summaries, and academic notes from a student’s entire high school 
year career. 

To display the Course History pages for a particular student, click the 
student in the seating chart then go to the Performance menu and select 
the Student Course History option.

The Course History function displays four pages:

! Course History Matrix
! Academic Summary Form
! Credit Summary Matrices
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! Narrative Comments Form

Administrators use the Course History features to print student transcripts, 
graduation requirement reports, and graduation status reports. 

Course History Matrix

Course History Matrix Fields

Field Description

Ln Line number of the student’s course history 
record. 

Mth Calendar month that the grade reporting 
period ended and the mark was earned.

Yr Year that the grade reporting period ended 
and the mark was earned.

Crs-ID ID number of the course for which the mark 
was earned.

Crs Title Course title as defined in the Course atom. 

Mark Mark earned for the course.
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Credit Attempted Credit attempted for the course.

Credit Completed Credit earned for the course.

School Year School year during which the course was 
taken. (If the school year was 98-99, then 98 
displays).

Term Term the course was taken (1 for first 
semester, 2 for second semester, and so on). 

Grd Student’s grade level while enrolled in the 
course. 

Rpt Tag Repeat tags indicate that the student took the 
course previously. They also indicate 
whether a repeated course counts toward a 
student’s credit totals. 

Citz Citizenship mark earned for the course (from 
the grade reporting record). 

Att1 The first attendance total for the course (from 
the grade reporting record). Data depends on 
your school’s setup. 

Att2 The second attendance total for the course 
(from the grade reporting record). Data 
depends on your school’s setup.

GPA Cumulative GPA for the default GPA defined 
by the school.

Field Description
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Academic Summary Form

The view-only Academic Summary form enables you to review summary 
information for a student’s GPA and academic credits. 

Academic Summary Form Fields

Field Description

GPA Summary 

GPA Types GPA abbreviations and descriptive types 
(defined in the GPA Definitions atom). The 
cumulative total for each GPA type displays 
to the right. 

Class Rank out of Indicates the student’s class size and the 
student’s academic placement within the 
class.

Credit Summary

Credits Attempted Number of credits the student has attempted 
to complete. 

Credits Completed Number of credits the student has completed 
to date.
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Credit Summary Matrices

The view-only Credit Summary matrices display a student’s progress 
toward meeting graduation requirements within requirement groups and 
subject areas. When you click a requirement group in the first matrix, the 
credits for each subject area in that group display in the second matrix. 

Credit Summary Matrices Fields

Field Description

Requirement Group Matrix

Ln Line number of the Requirement Group.

Requirement Group The name of the Requirement Group to 
which credit summary information applies. 
Select the line number of the requirement 
group to display totals required for the 
subject areas. 

Subject Area Matrix

Ln Line number of the subject area and related 
credit summary totals.
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Subject Area Subject area for which the credit information 
applies. Subject areas are the same for each 
Requirement Group, but credits change 
depending on the requirement group that you 
select. 

Credits Reqd Number of credits required within the subject 
area to meet Requirement Group 
specifications.

Total Compl Number of credits completed to date within 
the subject area for the specified 
Requirement Group. 

Now Enr Indicates potential credits when the student is 
currently enrolled in a course within the 
subject area. 

Still Needed Total credits in the Total Completed and Now 
Enrolled fields are subtracted from the 
Credits Reqd field to determine the number 
of credits Still Needed to meet subject area 
requirements for a selected Requirement 
Group.

Credit Summary Fields

Credits Attempted The number of credits the student has 
attempted to complete in the subject area for 
the selected Requirement Group.

Credits Completed The number of credits the student has 
completed to date in the subject areas for the 
selected Requirement Group.

Field Description
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Narrative Comments Form

The Narrative Comments form displays additional comments regarding the 
student’s high school career. For example, comments might note 
achievement awards and any special recognition received by the student, 
or they might note college courses taken by the student. 

Student Test Scores Function
The Student Test Scores function enables you to view a student’s test 
history with scores and ranking information. Test information covers all 
standardized tests that a student has taken from freshman year to the 
current date. Test history information comes from the SASIxp 
Standardized Testing atom and covers standardized student tests such as 
CTBS, SAT, DAT, and PH. 

To display the Standardized Testing History matrix for a particular student, 
click the student in the seating chart then go to the Performance menu and 
select the Student Test Scores option.
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Standardized Testing Matrix

You can double-click any row in the matrix to display a detail form for the 
selected test record. The test detail form provides this test information:

! Test parts
! Maximum possible score
! Raw score
! Standard or scale score
! Grade equivalent of raw score
! Percentile ranking of student’s score relative to other students
! Stanine score
! Normal equivalent
! Mastery of the test part

From the test score detail form, use the multi-record selection bar to view 
detail forms for other student standardized test information records. 

Standardized Testing Matrix Fields

Field Description

Test ID Identifier for the test. 

Description Description of the test.
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Test Date Date the test was taken.

Grd Student grade level at the time the test was 
taken. 

Month Month the test was taken.

Off-site Indicates whether the test was taken at 
school or at another location (Blank indicates 
at school, Y indicates off-site). 

Field Description
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Classroom for Administrators

Classroom is a SASIxp module created especially for teachers. Designed 
around an on-screen seating chart complete with student photos, it 
provides a class management system teachers use to quickly perform 
administrative tasks at their classroom workstation (Macintosh or 
Windows).

By clicking photos in seating charts and selecting functions from menus, 
the teacher can instantly take attendance and locate any student data 
needed in the classroom. In addition, SASIxp Classroom enables the 
teacher to:

! Create and arrange seating charts.
! Add new students to seating charts. 
! Remove dropped students from seating charts.
! Update attendance.
! Enter student grades.
! View student demographic, emergency, health and immunization, and 

discipline records as well as student test scores.
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SASIxp Integration
As a fully-integrated module of the SASIxp educational software, 
Classroom runs in the SASIxp environment and shares its graphic user 
interface. It also features the same power and ease of use that are 
hallmarks of the SASIxp educational software. 

The version of the SASIxp educational software that contains the 
Classroom module is referred to as SASIxp Classroom (or just 
Classroom). Unlike other SASIxp modules, you open the Classroom 
module from the Macintosh or Windows desktop with its own icon.

As an administrator, you log in to Classroom and select a teacher and 
class to access Classroom features. The seating chart for the selected 
class displays on the desktop, SASIxp Classroom menus are added to the 
SASIxp menu bar, and other features become available for use.

Because SASIxp Classroom is fully integrated with SASIxp software, all 
information comes from central data files on the school file server and is 
the latest information available. As soon as you select a class, you are 
alerted to any added or dropped students. After taking attendance, you 
can be alerted to students needing readmit slips. In turn, when you take 
attendance or record grades in SASIxp Classroom, the SASIxp database 
is updated instantly.

Full Integration

For administrators, full integration means that when you run SASIxp 
Classroom, you can:

! Use SASIxp functions alone.
! Log in as a teacher, open a class, and use SASIxp Classroom features 

alone.

Administrators who do not run SASIxp Classroom need only the SASIxp 
icon or alias. Administrators who run SASIxp Classroom need two icons, 
or aliases, one for the SASIxp educational software and another for 
SASIxp Classroom.

If you are an administrator who wants to run both SASIxp and SASIxp 
Classroom, you must use the CLASSxp icon or alias. 

Pearson Education Technologies recommends that you work in each 
environment separately.
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Classroom Functions
When you select a class (or the system selects one automatically), the 
SASIxp Classroom seating chart for that class displays on the desktop. 
SASIxp Classroom menus become available on the menu bar, and other 
SASIxp Classroom functions become available for use in the SASIxp 
environment. (The SASIxp environment includes the toolbar, message 
center, menu bar, SASI Modules Globe, and more.) You can open only 
one class at a time.

SASIxp Classroom includes:

! Seating Chart — Displays the names and photos of the students in the 
selected class. When you select one or more photos in a seating chart, 
the screens that you select from SASIxp Classroom menus are for 
those selected students.

! Class Information Window — Displays basic information about the 
selected class including date, period, term, teacher, course title, 
student name, total students in class, and total number of students 
who are present, absent, or tardy.

! Student and Class Screens— Contain data for individual students or 
for an entire class. To display screens, you select them from the three 
SASIxp Classroom menus.

! Class, Personal, and Performance Menus — List SASIxp Classroom 
functions. These menus display in the menu bar next to the File, Edit, 
Windows, and Data menus available for SASIxp software.

Starting Classroom as an Administrator
The SASIxp Classroom module is different from other SASIxp modules in 
that you open it directly from the Macintosh or Windows desktop with its 
own CLASSxp icon.

The system recognizes you as an administrator when you log in to the 
SASIxp Classroom using the CLASSxp icon. As an administrator, you 
have access to all classes for all teachers and to any folders and atoms 
that you have access to in the SASIxp environment. 

Administrators may have both SASIxp and SASIxp Classroom icons on 
their desktop. You must use the CLASSxp icon to run both at the same 
time. 
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Many SASIxp Classroom functions are not available until you select a 
teacher (which logs you in as that teacher) and one of the teacher’s 
classes. Then SASIxp Classroom functions and menus become available. 
When you finish working with SASIxp Classroom, you can close the class 
without exiting from Classroom.

When teachers log in to the system, Classroom starts immediately. 
Teachers have access to their own classes and to SASIxp Classroom 
functions. They can also access any SASIxp folders and atoms that have 
been assigned to them by an administrator. 

Both teachers and administrators connected to the network start SASIxp 
Classroom by double-clicking the CLASSxp icon from the Macintosh or 
Windows desktop.You then log in from the Welcome window that displays.

Login Steps for Administrators
Administrators use these instructions to log in to SASIxp Classroom: 

1. Double-click the CLASSxp icon. The Welcome window displays.

2. In the User ID field, type your SASIxp Classroom User ID. 
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3. In the Password field, type your password. (For security reasons, 
asterisks display instead of your password.) 

4. Click Login (or press Enter). The system displays the SASIxp desktop. 

5. Open the Classroom folder from the SASI Modules list. (If the SASI 
Modules list is not displayed, double-click on the SASI Modules globe 
on the desktop. You will have access to the same folders and atoms as 
you do in the SASIxp environment.)

6. Double-click the Teacher Selection atom. The system displays the 
Teacher Selection window. 

7. Double-click the name of the teacher that you want to log in as.

! If the teacher has only one class, the seating chart for that class 
automatically displays on the SASIxp desktop. In addition, the 
message “Loading students, please wait” displays in the message 
center.

! If your school uses schedules and the teacher has more than one 
class, the system displays the Class Selection window.

8. Select a class from the Class Selection window (if the class is not 
displayed already) by double-clicking on the name of the class. 

Changing Your Password

You can change your password from either the Welcome window or the 
lockout screen used to hide the SASIxp desktop.

Changing a Password from the Welcome Window

1. Double-click the CLASSxp icon. The Welcome window displays. 

2. In the User ID field, type your SASIxp Classroom User ID. 
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3. In the Password field, type your SASIxp Classroom password. (For 
security reasons, asterisks display instead of your password.)

4. Click Change Password. The system displays the User Password 
window. 

5. In the Enter your new password field, type a new password. 

6. In the Enter your new password again field, re-type your new 
password. 

7. Click Change to record your password and return to the Welcome 
window. 

8. Click Login to log on to SASIxp Classroom using your new password. 
(You can also click Cancel to save your password and close the 
Welcome window or click Exit to quit SASIxp Classroom.) 

Changing a Password from the Lockout Screen

1. Click the Screen Lock icon in the status bar above the message 
center. (If a time has been entered in the Minutes before Screen 
Locked field in your User record, the lockout screen displays 
automatically at that time interval.) 

2. In the Password field, type your SASIxp Classroom password. 

3. Click Change Password. The system displays the User Password 
window.

4. In the Enter your new password field, type a new password. (For 
security reasons, asterisks display instead of your password.) 

5. In the Enter your new password again field, re-type your new 
password. 

6. Click Change to record your password and return to the lockout screen 
(or click Cancel to restore your previous password).

7. Click OK to save your password and return to the system (or click Exit 
to save your password and quit SASIxp Classroom). 

Selecting Teachers and Classes
For administrators, the first step in using SASIxp Classroom is to select a 
teacher after you log in to the system. When you select from the Teacher 
Selection window, you are logged into the system as the selected teacher.
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SASIxp Classroom functions and menus become available to you after 
you select a class from the Class Selection window. 

Using the Teacher Selection Window

The Teacher Selection window lists all the teachers at your school by last 
name in alphabetical order (this list comes from the Teacher List atom 
created in the SASIxp educational software). 

Administrators display the Teacher Selection window by opening the 
Teacher Selection atom from the Classroom folder. 

1. Open the Teacher Selection atom from the Classroom folder. The 
system displays the Teacher Selection window. 

2. Double-click the name of the teacher you want to work with from the 
list displayed. You can move up or down through the list using the 
scroll bar. The system displays the Class Selection window with a list 
of classes taught by the selected teacher. 

Using the Class Selection Screen

The Class Selection screen lists all classes taught by the selected teacher. 
The system does not display this window for teachers who teach only one 
class or if your school does not use schedules (instead, the class seating 
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chart displays). Classes display for the selected term only. The current 
term is the default selection. If a teacher teaches more than one class 
during a period, the classes are combined on one line. 

If a teacher teaches a block class (one class that lasts more than one 
period) and your school takes attendance by period, each period of the 
block class is listed separately in the Class Selection window.

If a teacher teaches a block class (one class that lasts more than one 
period) and your school takes attendance by class, all periods for the block 
class appear on one line in the Class Selection window.
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You can access any class from the Class Selection window. The Class 
Selection window displays the current date, selected teacher, current 
(default) or selected term, type of classes you want to display, and a list of 
classes taught by the selected teacher, including the period and course 
title of each class. 

Opening a Class

1. Open the Teacher Selection atom. The system displays the Teacher 
Selection window. 

2. Select a teacher name in the list. The system displays the Class 
Selection window with a list of all classes taught by the selected 
teacher. 

3. Check the Term field to ensure that you are looking at the class for the 
term that you want (this field defaults to the current term). Select 
another term from the pop-up list if necessary. 

4. The Select Classes to Display field tells you what type of classes are 
currently displayed. Select another type from the pop-up list if 
necessary.

5. Select a class in the list. The system displays the class seating chart 
and the Class Information screen. 

How to Close, Log Out, and Quit Classes

When you finish a task in SASIxp Classroom, you can close the class, log 
out, or exit from the SASIxp software. 

Closing a Class

Use the Close Class function when you want to exit from the current class 
(or classes) and return to the Class Selection window and choose another 
class to open. 

Logging Out of SASIxp Classroom

From the Class menu, select the Logout option. You will not exit 
completely from the SASIxp software. The Welcome window displays so 
that another person can log into the system. (This feature is handy when 
two or more teachers share a workstation or when an administrator has 
been working with one or more teachers using the Teacher Selection 
window.) 
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Quitting SASIxp Classroom

From the File menu, select the Quit option (Command/Control Q) to exit 
completely from the SASIxp software and return to the Macintosh or 
Windows desktop . Before quitting, the system saves your desktop 
arrangement including any open folders. 

Setting Up Attendance Preferences
You perform attendance setup for SASIxp Classroom using the 
Attendance Preferences atom (from the Classroom folder). The 
Attendance Preferences atom enables you to define: 

! The attendance reasons that are available when you click student 
photos in class seating charts to take attendance. Each time you click 
a student photo, a different attendance reason displays. The system 
continues to cycle through the attendance reason list as you continue 
to click the student photo. 

! The order in which attendance reasons display when you click student 
photos in class seating charts to take attendance. 

! How attendance should be taken for block classes (classes that last 
more than one period).

! The attendance update rights available to all SASIxp Classroom users. 
These update rights determine how many days you can go back to 
change attendance reasons and how attendance should be taken (for 
example, from the seating chart on a daily basis). 

As an administrator, closing the Class Selection window deactivates all 
SASIxp Classroom functions. To reactivate SASIxp Classroom 
functions, you must select a teacher and class. When teachers close the 
Class Selection window or close the seating chart for their only class, 
the Welcome window displays.

As an administrator, you need to work from SASIxp softwareto go back 
further to update attendance reasons. 
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Attendance Preferences Screen

Performing Attendance Setup for Classroom

1. Open the Attendance Preferences atom (from the Classroom folder). 
The system displays the Attendance Preferences screen. 

2. In the Abbr field, select an attendance reason code from the pop-up list 
(which you access by clicking on the code you wish to change or in the 
next blank line of the Abbr column). When you exit this field, the 
description and type for the code displays in the Title and Type fields. 
To remove an attendance reason code, select Present from the pop-up 
list.

3. You can continue to add attendance reasons codes to the matrix until 
you reach the limit of 12. 

The order in which the attendance reasons display in rows of the 
matrix determines the order in which the reasons display as you click 
student photos in the seating chart. Add attendance reasons to this 
matrix in the order that you want them to display when taking 
attendance. The last attendance code on the list must be “Present.” 
“Present” displays as a blank line in the Attendance Preferences 
screen.
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4. In the Allow changes to Attendance for ___ Day(s) fields, type the 
number of days (0 – 180) that users can go back to update attendance. 
(Entering 0 means that the users have no update rights beyond the 
current day.) 

5. Check the Period or Class checkbox to determine how attendance is 
taken.

6. Check the Attendance from Seating Chart only checkbox if you want 
attendance taken exclusively using the seating chart

7. Click Save to save the data.

8. Click Close to exit the Attendance Preferences screen.

Creating the Seating File
Five data files (ACXA, ACXC, ACXH, ACXP and ACXS) control SASIxp 
Classroom. These files store data for the Classroom module including the 
students in each class, student status within classes, where student 
photos display in a seating chart and other information.

To create the Seating file, you must run the Update Seats atom (using the 
Create New Classroom Seat File option) after students have been 
scheduled in classes. This option automatically creates a default 
“Alphabetical” seating chart for each class. 

If a teacher teaches a block class (one class that lasts more than 
one period) and you select Class, all periods for the block class 
appear on one line in the Class Selection window.

Pearson Education Technologies recommends that attendance 
always be taken from the seating chart.

All other users must be logged out of SASIxp Classroom when you run 
the Update Seats atom. You can run Update Seats manually, allow the 
seating file to be updated in real-time, or schedule Update Seats to run 
during off-hours using the Send Update Seats to JobQ function from the 
Seats menu.
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The seating file can be updated manually from the Update Seats atom 
(using the Update Existing Classroom Seat File option). Run this option 
every night so that seating charts reflect changes in student schedules. 

Creating a New Seating File

1. Open the Update Seats atom (from the Classroom folder). 

2. Select the Create New Classroom Seat File option.

3. Click Create. The system displays this message:
Existing Seat file will be deleted, proceed?

4. Click OK to proceed (or click Cancel to abandon the creation process). 
A progress bar displays in the message center, along with these 
messages: 
Loading All Students, Loading the Master Schedule,
Processing Student Schedules, and Creating Seat file.

Maintaining SASIxp Classroom
The only maintenance you need to perform for SASIxp Classroom files is 
to update the Seating file. You should perform this update at the end of 
every school day or schedule nightly updates using the Job Queue, to 
incorporate any changes teachers have made to seating charts as well as 

Do not use Update Seats between the time student schedules have 
been revised using the Update Classes atom and the start of a new 
school term.
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changes to student schedules. The update function works for all classes, 
including split-week classes. The School file can also be set to make the 
Update in real-time.

Based on student class adds and drops reflected in the Seating file, 
SASIxp Classroom automatically prints lists of students entering or leaving 
classes when classes are opened.

Updating the Seating File Manually

1. Open the Update Seats atom (from the Classroom folder). 

2. Select the Update Existing Classroom Seat File option.

3. Click Update (or click Cancel to abandon the update process). The 
system displays this message:
Loading All Students, Preprocessing Seat File,
Loading the Master Schedule, Processing Student
Schedules, and Updating Seat file.

All other users must be logged out of SASIxp Classroom when you run 
the Update Seats atom. 

You may not want to update the seating file between the time 
student schedules have been revised using the Update Classes 
atom and the start of a new school term to allow teachers to continue 
entering grades and other information easily.
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Updating the Seating File in Real-Time

Allowing the seating file to be updated in real-time (as changes are being 
made) can consume a significant portion of your school’s network 
resources. Pearson Education Technologies recommends that schools 
with limited network resources not allow real-time updating.

Updating the Seating File Using Job Queue

The JobQ server enables you to schedule updates to the Seating file. 
Using JobQ enables you to update seats when no other users are using 
the system and helps ensure all users have the most current information. 
Send Update Seats to JobQ is accessed through the Seats menu. You 
have four scheduling options when you update seats using the Job 
Queue:

You may not want to allow real-time updates to the seating file during 
the first few days of each term because of the potential for a large 
number of changes being made at the same time.

Option Description

Urgent Enables you to update seats immediately.

Normal Adds the update seats job to the list of other 
pending jobs on the Job Queue Server.

Recurring Enables you to schedule multiple updates for 
the future.

Timed Delay Enables you to schedule a single update at a 
specified date and time in the future.
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Setting Up and Starting the Job Queue Server

1. Open the Job Queue Server atom (from the Utilities folder).

2. A message displays stating:
“Warning: Starting the Job Queue will close all open
forms!”

Click OK to continue. The system displays the Job Queue Server 
screen.

3. Select Default from the pop-up list in the Server Name field.

4. Click Quit Server. The systems displays the Welcome window.

5. Open the Update Seats atom (from the Classroom folder). The Send 
Update Seats to JobQ option is now available from the Seats menu.

The Job Queue server needs to be set up only once. You do need to 
start the server every day you want to update the seating file if your 
school does not have a dedicated server or a workstation functioning 
solely as a server.

You will need to log back into SASIxp Classroom after quitting the 
server.



Copyright © 2000–2004 Pearson Digital Learning Maintaining SASIxp Classroom  123

Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous

Manually Scheduling Updates Using Job Queue

1. Open the Update Seats atom (from the Classroom folder).

2. Select Send Update Seats to JobQ from the Seats menu. The system 
displays the Send Update Seats to Job Queue parameters screen.

3. Select the Priority to assign to updating the seating file.

4. Select the method by which you want to be notified when the seating 
file has been updated from the Notify Me field.

5. Select the server to send the job to from the pop-up list in the Send to 
Server Field.

6. Click OK to send the task to the server.

7. Start the server, if necessary. You will be notified when the update is 
complete.

If you select Urgent, the update runs immediately (or as soon as you 
start the server). If you select Normal, the task will be added to the 
list of jobs pending on the server.
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Scheduling a Single Update Using Job Queue

1. Open the Update Seats atom (from the Classroom folder).

2. Select Send Update Seats to JobQ from the Seats menu. The system 
displays the Send Update Seats to Job Queue parameters screen.

3. Select Timed Delay in the Priority field. Two fields appear on the 
screen (Time and Date) enabling you to enter the exact day and time 
you want the update to be run.

4. Select how you wish to be notified when the task has been completed 
from the Notify Me field.

5. Select the server to send the job to from the pop-up list in the Send to 
Server field.

6. Click OK. 

7. Start the server, if necessary. Update Seats will run at the specified 
time and date. The system will notify you when the update is complete.
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Creating Patterns for Job Queue

1. Open the Update Seats atom (from the Classroom folder).

2. Select Send Update Seats to JobQ from the Seats menu. The system 
displays the Send Update Seats to Job Queue parameters screen.

3. Select Recurring in the Priority field.

4. Select Create from the pop-up list appearing beneath Recurring in the 
Priority field. The system displays the Job Queue Patterns screen.

5. Type a name for the pattern you are creating in the Pattern Name field.

6. Type a brief description of the pattern in the Description field.

7. Select how often you want the pattern to repeat.

8. Enter a Start date (the system uses today’s date as the default).

9. Select when you want the pattern to end, either after a specific number 
occurrences or on a specific date.

10. Click Save. The system displays the message:
“Add new record?”

Click OK. The system displays the Job Queue parameter screen.You 
can now schedule updates using the pattern you just created.

Before you can run regular updates using Job Queue, you must create 
at least one pattern for it.
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Scheduling Multiple Updates Using Job Queue

1. Open the Update Seats atom (from the Classroom folder).

2. Select Send Update Seats to JobQ from the Seats menu. The system 
displays the Send Update Seats to Job Queue parameters screen.

3. Select Recurring in the Priority field. The system displays a field, 
where you can select from a list of previously created patterns for 
performing updates on a regular basis.

4. Select the method by which you want to be notified when the seating 
file has been updated in the Notify Me field.

5. Select the server you wish to send the job to from the pop-up list in the 
Send to Server field.

6. Click OK to send the task to the server. 

7. Start the server, if necessary. Updates will run according to the 
selected pattern. The system will notify you when each update is 
complete.

If no patterns exist in the pop-up list, you must create at least one 
pattern before you can schedule multiple updates.
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Running the CLS01 Report
Administrators can run the CLS01 report from the Class Attendance atom 
to list the teachers who still need to take attendance for the current 
calendar day. 

You can run this report for each period, individual teachers or at the end of 
each day. Teachers who have already taken attendance in SASIxp 
Classroom are not included in the report. 

This report is intended for the current date only. If you attempt to run the 
report for a previous date you may get unreliable information. 

Report information includes:

! Date for the report information. 
! Period number (at period attendance schools).
! Term for the report information. 
! Course titles and ID.
! Days on which each class meets.
! Teacher name and number for each class.
! Room number of each class. 

How To Run the CLS01 Report

1. Open the Class Attendance atom (from the Attendance folder). 

2. From the Class-Attendance menu, select the Tch Not Taken Attend 
(CLS01) option. The system displays the CLS01 report interface.

3. Check the Date field to ensure it displays the current date. 

4. In the Period field, select a range of periods to include on the report 
from the pop-up list. To print data for only one period, select a range of 
only that period. If no range is selected, the system defaults to all 
periods.

Pearson Education Technologies recommends that you quit the SASIxp 
Classroom environment, log into SASIxp software and run this report 
from that environment. However, if you must run this report from the 
SASIxp Classroom environment, Pearson Education Technologies 
recommends that you log out of Classroom then log back in, especially if 
you have been working as one or more teachers through the Teacher 
Selection window. This process clears any system filters that may still be 
active.
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5. In the Teacher Num field, type the number of a specific teacher or a 
range of teachers to include on the report. If these fields are left blank, 
the report runs for all teachers.

6. Click Print to print the report. 
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SASIxp Features in Classroom

This section provides you with an overview of the features within SASIxp 
Classroom.

A Look at SASIxp Features
Most SASIxp features are available for use along with SASIxp Classroom. 
If you have been assigned folders and atoms, they are available on the 
Classroom desktop. However, you only need folders and atoms if you 
perform SASIxp functions outside of the SASIxp Classroom module. You 
can access all SASIxp Classroom functions from SASIxp Classroom 
menus. 
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SASIxp Desktop Features

The desktop provides the working environment for SASIxp and SASIxp 
Classroom. The desktop includes the workspace, the toolbar, the 
message center, the menu bar, and other system features. 

Workspace

The workspace is the area from which you view and work with SASIxp 
features, functions, and data. The SASIxp Classroom seating chart 
displays in the workspace when you open a class. Data forms also display 
in the workspace when you open them from Classroom menus or from 
SASIxp atoms. 

SASIxp Modules Globe

The globe icon represents all folders and atoms that are assigned to you. It 
enables you to access all items assigned to you by the SASIxp 
administrator. 

Folders

Folders (represented on the desktop by briefcase icons) store atoms. An 
open briefcase indicates that the folder is open on the desktop. Double-
click a briefcase icon to open a folder. 
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You can create your own folders to store and organize data atoms that you 
create for student records. From the File menu, select the New Folder 
option.

Atoms

Atoms launch SASIxp applications that display data forms allowing 
teachers to review records (the same forms are used for SASIxp 
Classroom). They may also be used by Security Officer not currently 
logged in as a teacher to activate application menus.

Double-click an atom to launch it. You can leave atoms open in the 
workspace background as you work with other data. Click the atom data 
form anytime to display it in front of your other work. 

SASIxp contains both system-supplied atoms and user-created atoms. 
System atoms are represented by picture icons. User-created atom icon 
pictures display a special symbol to identify them. 

! Data atoms are used to save records in separate atoms. You can open 
these atoms to quickly access records. The symbol for a data atom is a 
data form.

! Query atoms are used to save query statements for repeated use. The 
symbol for a Query atom is a question mark.

! Filter atoms are used to save query statements as filters for screening 
data so that only certain records are available when you print reports 
or search for specific information. The symbol for a Filter atom is a 
funnel.

! Report atoms are used to save reports for repeated use. The symbol 
for a Report atom is a printer with a page printing out.

System Filter Folder

The System Filter folder contains atoms created by queries. The queries in 
filter atoms work in the background to screen data so that only certain 
records are available when you run reports, perform a Find, or perform 
another query. Represented by a briefcase with a picture of a funnel, the 
System Filter folder cannot be erased or moved. Filter atoms are active 
while they are stored in the System Filter folder. Removing a filter from this 
folder deactivates it. You may find that a Security Officer has locked one or 
more filters in the System Filter folder.
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In Folder

The In folder receives any mail or user-created atoms sent to you over the 
network via the Send atom. User-created atoms can contain reports, 
queries, forms, and so on. Represented by a briefcase icon with a picture 
of an in-basket, the In folder cannot be erased or moved. A red arrow 
displays on the In folder icon when an atom or e-mail message is received. 
You can open atoms from the In folder or move them to another folder, to 
the workspace, or to the toolbar. Use the Eraser to remove them from the 
desktop.

Eraser

You can use the eraser, located in the lower right corner of the desktop, to 
remove an object. Click and hold the item that you want to remove, drag it 
over the Eraser icon, then release the mouse button. The Eraser moves 
back and forth and you see chalk dust. The icon for the item that you just 
removed moves into the Eraser window. You must double-click the Eraser 
to view removed items. From the Eraser window, you can drag items back 
onto the desktop to restore them. You can permanently delete erased 
objects if you go to the desktop file menu and select the Clean Eraser 
option. 

Toolbar

The Toolbar displays on the left side of the desktop. It provides a place to 
make atoms that you use frequently easy to find and readily accessible. A 
toolbar icon is an alias that represents an atom stored elsewhere on the 
desktop. You can double-click an alias in the toolbar to launch the atom as 
usual. 

! You can create multiple toolbars with different atoms for different 
tasks.

! You can create multiple aliases for one atom and store them in 
different toolbars.

! You can create an alias for any SASIxp atom (system-supplied or 
user-created). 

Message Center

The Message Center (located at the base of the desktop) contains four 
information bays, a status bar with system icons, and the Mini Pic box for 
displaying photos.
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! The top left bay displays a description for what the mouse pointer is 
currently pointing to (such as a field in a form or a desktop 
component). The information displayed changes as you move the 
mouse. 

! The lower left bay displays any error messages generated when you 
perform a function. This bay also displays progress bars that indicate 
how much of a function has been completed.

! The right bays enable you to display data from up to four fields. You 
can use these bays when you are working in forms that do not contain 
fields that you want to view. As you move among records, the data in 
these bays displays data relevant to the current record. 

! The Mini Pic Box automatically displays any photo attached to the 
record that you display. Double-clicking the Mini Pic displays a larger 
floating photo for use with forms without photos.

Status Bar

The Status Bar displays the name and number of the school that you are 
currently logged into, the school year logged into, the User ID used to log 
in, and the current date. It also contains several system icons that you can 
click once to use. 

! Data Lock Icon — Displays all data-form fields in a view-only mode so 
that data cannot be changed accidentally. To unlock data, click this 
icon again, enter your password in the field provided, then click OK.

! Screen Lock Icon — Hides the SASIxp desktop behind a lockout 
screen so that data cannot be viewed or changed by unauthorized 
users. You can use this icon to hide the screen whenever you want, 
even if your screen is locked automatically at a time interval set in your 
user record. To unlock the screen, enter your password in the 
Password field provided then click OK. To quit SASIxp Classroom from 
here, click Exit.

! Finder Icon — Enables Macintosh users to drop to the Macintosh 
desktop without exiting from SASIxp Classroom (open forms as well as 
the toolbar remain displayed). To redisplay the full SASIxp desktop, 
click the icon again. Windows users can drop to the Windows Program 
Manager by clicking the minimize button in the upper right corner of the 
SASIxp screen. This minimizes Classroom to an icon in Windows. 
Double-click the icon to redisplay the SASIxp desktop.

! Filter Icon — This displays when a Filter atom is contained in the 
System Filter folder. It serves as a reminder that one or more filters are 
active. You can click this icon as a shortcut for opening the System 
Filter folder. This icon is always active for teachers logged into 
Classroom.
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Menu Bar

The Menu Bar displays File, Edit, Windows, and Data menus with 
functions for use in both SASIxp and SASIxp Classroom. When SASIxp 
Classroom is running, it also displays the Class, Personal, and 
Performance menus. When an application atom is activated, the menu bar 
displays any application menu available for that atom.

File Menu Functions

Function Description

New folder (N) Enables you to create folders. Contains a 
Save As field for naming new folders and 
enables you to specify where a folder should 
be stored. The top field displays the storage 
area currently selected and contains a list of 
all the folders currently open (you can select 
a storage area from here). The list below the 
top field displays any folders or atoms 
contained in the selected storage area 
(atoms display in italics). To select a storage 
area from this list, click a folder then click 
once on the Open button. A fast way to select 
the desktop as the storage area is to click 
Desktop.

Open (O) Opens a selected folder or atom. Click a 
closed folder or atom icon to select it. (You 
can also open folders and atoms by double-
clicking them). 

Close (W) Closes a selected folder or atom. Click a 
closed folder or atom icon to select it.

View by Name Enables you to view atoms in an open folder 
by name in alphabetical order. If the atoms in 
a folder are already displayed by name, this 
option is called View by Icon, which enables 
you to view atoms in an open folder by icon.
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Duplicate (D) Enables you to copy an atom so that it can be 
stored in more than one location on the 
desktop. To copy an atom, first click it to 
select it. From the File menu, select 
Duplicate Atom. You can also hold down the 
Option key (Macintosh) or the Alt key 
(Windows), click the atom, then drag the 
outline that displays to the workspace. Data 
changes performed after opening any copy of 
the atom get reflected in all atom copies. 

Atom Info (I) Displays information form that provides the 
name, short name, description and atom type 
properties of the selected atom. Also allows a 
hotkey to be specified for launch date of the 
atom.

Install Atom Enables you to install an atom from the 
network on your SASIxp desktop.

Save Desktop (S) Enables you to save the desktop in its current 
arrangement. If any atoms are open, this 
option is called Save Data. You can also use 
this option to save data on the currently 
selected form.

Find Atom Enables you to quickly locate a folder or atom 
without searching through folders on the 
desktop. Use the lists to select entries for the 
first two fields (defaults are name and starts 
with, respectively) and type data in the third 
field. Your search criteria to locate the 
Emergency atom might read name starts with 
emergency. Click Find. The system highlights 
the atom that matches your criteria (the 
system may open a folder to locate the 
atom). You can search on partial words in the 
third field (stu for student). 

Find Atom Again Finds the next atom or folder that matches 
your Find Atom search criteria. You might get 
a copy of the atom or a different atom that 
begins with the same letters. 

Function Description
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Edit Menu Functions

Page Setup Displays setup options for printing atom data 
forms and reports. Settings include paper 
size and page orientation. 

Print (P) Prints an open window or form on the 
desktop. If multiple items are open, the active 
item (in the foreground) prints. 

Clean Eraser on 
Desktop

Permanently deletes all contents (atoms and 
folders) in the Eraser. Double-click the Eraser 
window to open it and check its contents 
before emptying it. For any item that you do 
not want to delete permanently, drag it onto 
the desktop before deleting Eraser contents. 

Quit (Q) Enables you to exit from SASIxp and return 
to the Macintosh desktop or to Windows. The 
system saves the current desktop 
arrangement and closes any open atoms. 

Function Description

Undo (Z) Undoes the entry you just typed. With the 
cursor still positioned in the same field, select 
Undo. The text is removed and the previous 
entry is restored.

Cut (X) Copies the data from a field. Highlight the 
field contents then select Cut. You can use 
the Paste function immediately to put the cut 
contents into a different field on any form. 

Copy (C) Copies data in a field. Highlight the field 
contents then select Copy. You can use the 
Paste function immediately to put the copied 
contents into a different field on any form.

Paste (V) Puts cut and copied data into a field. Click the 
field in which you want to put the cut or 
copied data then select Paste. 

Function Description



Copyright © 2000–2004 Pearson Digital Learning A Look at SASIxp Features  137

Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous

Windows Menu Functions

Clear Removes data from a field. Highlight the field 
contents then select Clear. 

Select All Selects all closed folders and all atoms in 
open folders. You can move them all, erase 
them all, or select the same option for them 
all (such as Open or Atom Info). Click once 
anywhere on the desktop to de-select all 
items. 

Function Description

Arrange Windows Arranges all open forms in an overlapped 
cascading pattern so that the Title Bar of 
each one is visible. Most forms cascade from 
the upper left corner of the workspace. The 
folders display in the order in which you 
opened them with the most recently opened 
folder visible at the front. 

Names of Open
Folders and Atoms

Displays the names of all open folders and 
atoms. This makes it easy to find forms 
hidden behind other forms. Select an item 
from this list to display it in the forefront. 

Function Description
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Data Menu Functions

Function Description

Find (F) Clears all form fields and enables you to 
search the active form according to criteria 
you specify any form field. 

Add (A) Enables you add a new record to a file.

Delete Permanently removes a selected record. 

Inactivate Inactivates a selected record (but maintains it 
in the file). 

Next ( ] ) Advances to the next available record (like 
the Forward arrow). 

Previous ( [ ) Returns to the previous record (like the 
Backward arrow). 

Sort List Enables you to organize a matrix list 
according to the values in one or more matrix 
columns. Click a column heading then select 
this option to sort by the selected column. 
You can sort by multiple columns if you hold 
down the Shift then click each column 
heading in the order in which you want the 
system to perform the sort. 

Reset Columns Width Resets all matrix widths to their original size. 
To resize a matrix column, click the right 
edge of its heading so that a cursor with left 
and right arrows displays. Then drag the 
cursor to resize the column width. 

Export List Exports matrix data to a file in a format 
compatible for use with other applications 
(such as spreadsheets or word processors). 

Graph Enables you to display matrix data in various 
graph formats. Select one column or hold 
down the Shift key and click the heading for 
each column you want to include in the 
graph.
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Working with Data Forms

The data forms available in SASIxp Classroom are the same as the forms 
used in SASIxp atoms. These forms display records for students or 
classes. The number of pages in each data form varies. Some pages 
display as data matrices (columns and rows that contain data cells) and 
some pages contains a series of data fields. 

The records displayed in data forms come from the central school data 
files contained in SASIxp atoms. Many data forms available in SASIxp 
Classroom contain view-only records meaning that you cannot enter data 
into, or modify, the records unless you have security rights to the files that 
contains those records. 

Show Item Boxes Displays gray outlines around all editable 
fields in the selected form. This makes it 
easier to see where each field begins and 
ends. The name of the function changes to 
Hide Item Boxes after item boxes display. 
Item Boxes display for all forms if this option 
is selected in your User record.

Show Control Buttons Displays three buttons at the bottom of all 
data forms. On the left and right are larger 
versions of the Forward/Backward Arrows 
found at the top of forms. In the center is a 
magnifying glass that quickly activates the 
Find mode.

Atom Menu Functions Atom menus list the functions and reports 
available for specific atoms. These atom-
specific menus display in the menu bar when 
an atom is launched and change as you open 
different atoms. 

Please note that application atom menus are only available if you are a 
Security Officer who is not currently logged in to the Classroom module. 
(You are logged in to Classroom if you already selected a teacher and a 
class). 

Function Description
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You can use specific data forms to record attendance and enter grades in 
grade reporting and progress reporting records. In addition, you may be 
able to update attendance for a certain number of days or periods in the 
past, depending on the attendance update rights assigned to all SASIxp 
Classroom users at your school.

Administrators can view records for previous years using the Change/
School Year atom. All records displayed in SASIxp Classroom are for the 
current school year unless a Security Officer has modified your User 
record so that you log into a different school year.

You can display data forms using class seating charts and menus on the 
menu bar. Once a data form displays, you can:

! Locate other records in that form.
! Perform a Find to view a list of records.
! Create a data atom for one record or for a list of records. You can then 

launch that atom to quickly access the record or record list. 
! Drag and drop a data atom onto any other SASIxp application atom to 

display additional information.

Displaying a Data Form for One Student

1. Display the class seating chart. 

2. Click the student in the seating chart. The system outlines the student 
photo in red and activates menu options that apply to students. 

3. Go to the Personal menu or the Performance menu and select the data 
form option that you want. The system displays the data form with 
information about the selected student. 

Displaying Data Forms for Multiple Students

1. Display the class seating chart.

2. Select all students in the seating chart by holding down the Shift key 
and clicking each student in the chart. The system outlines each 
student photo in red and activates menu options that apply to students.

3. Go to the Personal menu or the Performance menu and select the data 
form option that you want. The system displays multiple data forms 
(one for each student) with information about each selected student.
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Display All Data Forms for One Student

1. Display the class seating chart. 

2. Click the student in the seating chart. The system outlines the student 
photo in red and activates menu options that apply to students. 

3. From the Personal menu, select the Full Student Data option. 

Clearing Selected Students

Click any empty seat in the seating chart. The red outline that displays 
around the photo of selected students disappears, and menu options 
applying to students become unavailable. 

Displaying Additional Records in Forms

Once you have displayed one record in a data form, you can display other 
records using these methods:

! Click the Forward/Backward arrows at the top of the form or in the 
Control buttons at the bottom of the form. This displays the next or 
previous student in the seating chart (or the next or previous class if 
you selected more than one class in the Class Selection window). A 
red outline moves over student photos as you continue to click these 
items. Hold down the mouse button to scroll more quickly. 

! Go to the Data menu and select the Next or Previous option. This 
displays the next or previous student in the seating chart.

! Go to the Data menu and use the Find function to search for records. 
This function enables you to locate quickly the records you want 
without having to display all record one at a time. This is useful if you 
are displaying more than one class in the seating chart.

Finding Records

The Find function (on the Data menu) enables you to locate one or more 
records quickly without having to scroll through all records one at a time. 
This function clears the current form of all data so that you can enter 
search criteria into available fields. The Find button displays in the lower 
right corner of the active data form. You can also click the magnifying 
glass at the bottom of the form to activate the Find function. This function 
is available only when a data form is open.
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Depending on the search criteria that you enter, Find may display one 
record or a matrix of records that meet your criteria. From a matrix, you 
can select the record that you want to view in the data form. You can also 
view multiple records depending on your system’s RAM (Random Access 
Memory). It takes about 8mb of RAM to display 15 forms at once. 

Finding Records

1. Display the data form that you want.

2. From the Data menu, select the Find option. You can also click the 
magnifying glass icon in the data form. The system clears all data form 
fields. 

3. Enter search criteria in any available fields. 

4. Click Find or press Enter.

Depending on the search criteria that you enter, the system displays 
the record that matches your criteria or a matrix of records that match 
your criteria. 

Displaying Records from a Find Matrix

The matrix produced by the Find function displays a list of all the records 
for students in the seating chart that match your search criteria. You can 
view the number of records found if you scroll to the end of the matrix. 

From a matrix list, you can select one or more records to display in the 
active data form (the matrix remains open in the background). Each record 
displays in a separate data form. 

Locating One Record in the Active Form

Double-click any ID in the Student ID column. You can also click an ID 
then click Open. The record displays in the active data form.

Locating Multiple Records in the Active Form

1. Hold down the Shift key and click the ID for each record that you want 
(ensure that each row becomes highlighted). 

2. Click Open. The selected records display in separate data forms in the 
order that they display in the matrix. 
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Closing a Record Opened from a Matrix

Click Close in the data form for each open record. You can also click the 
Close box (Macintosh) or double-click the Control-menu box (Windows) for 
each record.

To close ALL open forms at once (including the matrix), hold down the 
Option key and click the Close box (Macintosh) or hold down the Alt key 
and double-click the Control-menu box (Windows) in the top form.

Using SASIxp Features with Classroom

As you work with SASIxp Classroom, you can take advantage of a variety 
of SASIxp features to work more quickly and efficiently. For example, you 
can:

! Use SASIxp’s drag-and-drop capability in a number of ways to move 
students into seating charts, to display a different record in an open 
data form, or to create data atoms for storing records or lists.

! Create folders for storing and organizing any atoms you create.
! Use toolbars to display aliases for any atoms and folders you create 

(or for any atoms and folders that have been assigned to you).
! Use the data bays in the message center to display additional data as 

you work in forms that do not contain fields for that data.

Drag-and-Drop Capability

The drag-and-drop capability in SASIxp gives you added speed and 
flexibility in working with forms and records. You can:

! Drag and drop folders and atoms to move them on the desktop.
! Drag and drop a student record field from one form onto another form 

to display that student’s record in the second form.
! Drag and drop a student record field from one form onto any student-

related atom to launch that atom and display the student’s record in the 
atom form.

! Drag and drop fields from a record or from a list to create a data atom 
for that record or list. You can then double-click that atom to instantly 
access the record or list.

! Drag and drop an atom into a toolbar bay to create an alias for that 
atom. Double-click the alias to launch the atom.
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Using the Drag-and-Drop Technique

1. Click any object on the desktop (field, student photo, atom, folder) and 
hold down the mouse button while dragging the mouse across the 
desktop. 

2. Release the mouse button to drop the object. When an object is over a 
closed atom, brackets display. When an object is over a closed folder, 
directional arrows display.

Creating Data Atoms

Data atoms enable you to save a record or list separate from the atom in 
which the data is originally stored. You can then access that record or list 
instantly by double-clicking the atom that you create to store the selected 
data. Creating data atoms means that you do not have to use the Find 
function or recreate a list every time you want to access specific data. 
When you save a list of records in a data atom, you can still display 
individual records by double-clicking items in the list. 

If you have access to the Query atom, you can create Query and Filter 
atoms. If you have access to application atoms, you can create Report 
atoms.

To create data atoms in SASIxp Classroom, you can drag and drop form 
fields and matrix fields into the workspace or you can drag and drop 
student photos from the seating chart into the workspace. Use the photo 
method to create a data atom for just the Student form or for the default 
form selected in Teacher Preferences.

Creating a Data Atom for One Record

1. Display any data form then display a student record in the data form if 
the form is designed for individual students. 

2. Click and hold any available data field in the form. A dotted line 
displays around the selected field. 

3. When you see the dotted line around the selected field, drag the dotted 
outline into the workspace and drop it. When you drop the field, the 
system displays the same SASIxp atom icon where the original data is 
stored except that a small orange data form symbol indicates the new 
atom is a Data atom. 

4. Click the new Data atom then go to the File menu and select the Info 
option. From this option, you can give the atom a different name, enter 
a description, assign a Hot Key, or lock the atom. 
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Create a Data Atom for a List of Records

1. Display any data form then display a student record in the data form if 
the form is designed for individual students.

2. Perform a Find using criteria that results in a matrix of the student 
records that you want. 

3. Hold down the Shift key and click the ID of each student that you want 
to include in the Data atom. Ensure that the row for each student you 
want is highlighted. 

4. Click and hold any cell in the matrix. A dotted line displays around the 
selected cell.

5. When you see the dotted line around the selected cell, drag the dotted 
outline into the workspace and drop it. When you drop the field, the 
system displays the same SASIxp atom icon where the original data is 
stored except that a small orange data form symbol indicates the new 
atom is a Data atom. A word list also displays underneath along with 
the name of the first student in the list. This Data atom contains the list 
of all students that you selected from the matrix. 

6. Click the new Data atom then go to the File menu and select the Info 
option. From this option, you can give the atom a different name, enter 
a description, assign a Hot Key, or lock the atom.

Displaying the Record Inside a Data Atom

Launch the Data atom to display the record or list contained in the atom. 
You can work with records in the Data atom as you would in any other 
atom. 

Creating Folders

You can create your own folders to store and organize data atoms that you 
create for student records. You can move items into folders that you create 
by dragging and dropping them or by copying them. 

Creating a New Folder

1. From the File menu, select the New Folder option. The system 
displays the window for creating folders. 

2. In the top field of the window, select a folder storage area from the list.

3. In the Save as field, type a name for the new folder. 
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4. Click Save to create and save the new folder (or click Cancel to 
discard the folder). A briefcase icon for your new folder displays in the 
selected storage area. 

5. Click the new folder then go to the File menu and select the Info option. 
From this option, you can enter a folder description, assign a Hot Key, 
or lock the folder.

Adding Atoms to an Open Folder

Click the atom that you want to add to the open folder, then drag and drop 
it into the folder. If you want to add a copy of an atom to the open folder, 
hold the Option key (Macintosh) or the Alt key (Windows) then click the 
atom, and drag and drop it into the open folder. The original atom remains 
unaffected while a copy is stored in your folder. 

Adding Atoms to a Closed Folder

Click the atom that you want to add to the closed folder, then drag it over 
the folder icon until the folder icon is highlighted. Drop the atom onto the 
highlighted folder. 

Using Data Fields in the Message Center

You can use the four data fields (or the Personal Data Center) in the right 
bays of the Message Center to display data that is not contained in the 
form that you are currently viewing. For example, while looking at Health 
atom data forms, you might want to know student birth dates and teachers, 
neither of which displays in any health atom data forms. You can see this 
information, however, if you include these fields in the Message Center. 
Data in Message Center fields changes to reflect information for the 
student currently selected as different records are displayed in the data 
form.

Things to keep in mind:

! As you move among records, the data in the Personal Data Center 
fields displays data relevant to the current record.

! The fields in the Personal Data Center remain there until you select 
new fields. 

! Since the top line of data displays the same student information in all 
data forms, you might want to select other fields to display in the 
Personal Data Center. 
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Selecting Fields for Information Bays

1. Display any data form designed for individual students.

2. Click and hold any available data field in the form (even if it is blank). A 
dotted line displays around the selected field.

3. Drag the dotted outline over one of the Personal Data Center fields 
and drop it there. The system activates the selected data form field in 
the Personal Data Center. 

Replacing Fields in Information Bays

1. Display any data form designed for individual students.

2. Click and hold any available data field in the form (even if it is blank). A 
dotted line displays around the selected field.

3. Drag the dotted outline over a Personal Data Center field that already 
contains an active data form field and drop it there. The system 
activates the newly selected data form field in the Personal Data 
Center.

Removing Fields from Information Bays

Hold down the Shift and Option keys (Macintosh) or the Shift and Control 
keys (Windows), then click each field you want to remove. The system 
removes the data form field from the Personal Data Center. 

Using Toolbars

You can use the toolbar to display aliases for application atoms that are 
assigned to you or for any atoms that you create. An atom alias represents 
an atom that is actually stored somewhere else on the desktop. You can 
launch an atom from an atom alias on the toolbar without having to search 
through folders to find the original atom. 

You can create more than one toolbar, and aliases for the same atom can 
exist on multiple toolbars. The number of available bays on a toolbar range 
from five to eight depending on your monitor size. 

You can access all available toolbars from the pop-up list above the actual 
toolbar or use the Forward/Backward arrows that display there. Options on 
the Toolbar menu enable you to create, rename, empty, and delete 
toolbars. 
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Displaying a Toolbar

From the pop-up list that displays above the toolbar on the left side of the 
SASIxp desktop, select a toolbar. You can also use the Forward/Back 
arrows to cycle through a list of available toolbars. 

Launching an Atom with an Alias

1. Display the toolbar that contains the atom alias that you want.

2. Double-click the atom alias on the toolbar to launch the atom. You can 
work with pages and data in the atom as you normally would. 

Creating a New Toolbar

1. From the pop-up list that displays above the toolbar on the left side of 
the SASIxp desktop, select the New Toolbar option. The system 
displays a window for naming the new toolbar. 

2. Type a name for the new toolbar.

3. Click Save to create and save the new toolbar (or click Cancel). The 
new toolbar displays with empty bays. 

4. Open the module or folder that contains the atom that you want to add 
to the toolbar. 

5. Click the atom then drag and drop it into any empty bay on the toolbar. 
The system displays the same icon for the atom alias that is used by 
the original atom. 

Naming a Toolbar

1. Display the toolbar that you want.

2. From the pop-up list that displays above the toolbar on the left side of 
the SASIxp desktop, select the Rename Toolbar option. The system 
displays a window for re-naming the toolbar.

3. Type a new name for the new toolbar.

4. Click OK to save the new toolbar name (or click Cancel to restore the 
original name). 
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Emptying a Toolbar

1. Display the toolbar that you want to empty. 

2. From the pop-up list that displays above the toolbar on the left side of 
the SASIxp desktop, select the Empty Toolbar option. The system 
removes all aliases from the toolbar but retains the name of the 
toolbar. You can add new aliases to the toolbar at this point. 

3. The system displays a window for re-naming the toolbar.

Deleting a Toolbar

1. Display the toolbar that you want to delete. 

2. From the pop-up list that displays above the toolbar on the left side of 
the SASIxp desktop, select the Delete Toolbar option. The system 
removes the toolbar contents and name so that they are no longer 
accessible. 

Removing an Alias from a Toolbar

1. Display the toolbar that you want.

2. Click the alias that you want to remove then drag and drop it over the 
Eraser icon in the lower right corner of the workspace. The Eraser 
moves back and forth as chalk dust displays, and the system places 
the removed atom alias in the Eraser folder. 

3. From the File menu, select the Empty Eraser option to remove the 
atom alias and all other erased contents from the system permanently. 

Printing from Classroom
There are several ways to print data from SASIxp Classroom. If you have 
access to SASIxp application atoms, you can print any of the reports in 
those atoms while logged in to Classroom. 

There are three reports available for printing from the Class menu. You 
can also print your Notecards for students and any available data forms. 

Before you print, make sure your workstation is connected to the correct 
network printer using the Mac Chooser or the Windows Printers option. 
You may also want to set the page orientation to landscape using the 
Page Setup option on the File menu. This orientation works best for data 
forms.
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Printing Reports

There are three reports available for printing on the Class menu:

Printing a Report

1. From the Class menu, select Print Report. The system displays a 
submenu consisting of three reports.  

2. Select the report that you want. The system displays the Report 
Interface Form.

3. Indicate the report options you want included on the report then Click 
Print.

How to Print Data Forms

You can print a copy of any data form available in SASIxp Classroom. You 
can also print windows such as the Class Information window.

Report Description

Class Roster Prints a roster list of all students in the class 
currently displayed in the seating chart.

Seating Chart Prints a copy of the seating chart currently 
displayed (without student photos). The 
report identifies school name, class name, 
period (if applicable), and date.

Class Attendance Prints a Class Attendance Summary, which 
can serve as an audit verification report for 
teachers. The report covers a one-month 
period and includes absence reasons for 
each day as well as totals for absences, 
unverified absences, and tardies. It also 
includes a space for teacher signature.

The dimmed out reports are not currently available.
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Printing a Data Form or Window

1. Display the form and record you want to print.

2. If you are printing data from a matrix and only want to print selected 
matrix rows, hold down the Shift key and click each row that you want 
to print. Ensure that each row with the record that you want is 
highlighted. 

3. From the File menu, select the Print option. The system displays the 
print window with several options. 

4. In the Printout Title field, enter a title for your report or use the default 
title. 

5. Select one of the two format options displayed:

! If you are printing a matrix or a Notecard with lots of text, select the 
Format as an Expanded Table option. This prints all data in the 
matrix, including data that doesn’t fit in the display area of the 
matrix.

! If you selected rows or columns in Step 2, select the Print Selected 
Rows & Columns Only check box.

! If you want grid lines to display on the printout, select the Print Row 
Dividing Lines check box.

! If you are printing a form without a matrix, select Format as a 
Window. If you select this option for a matrix, only the data 
currently displayed in the display area prints.

6. Click OK to print (or click Cancel to abandon the print job). The system 
displays a print setup dialog box with options. 
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7. Select print setup options.

8. Click OK to print (or click Cancel to abandon the print job).
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